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1. Introduction

This handout is a collection of guided exercises that allow the student to acquire the practical bases of the graphic representation of parts
and Computer Aided Design (CAD). The work is done using Catia® V5 software. Based on a power transmission mechanism, it gives a
procedure for drawing 3D parts, drawing 2D details for manufacturing, assembling 3D parts and drawing it for assembly. Some notions of
methodologies are also presented on the design of parts as well as on the management of assemblies.

Thanks :

Benoit Carton, Mathieu Benoit, Thomas Goéte McCarthy, Christophe Mattheeuws, Claude Ramseyer.

Writing — last update: Jennifer Gasparoux — August 2010

Contact: Jennifer Gasparoux, jennifer.gasparoux@epfl.ch

Daniel Kremer, daniel kremer@epfl ch
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2. Graphic representation of the parts (source: Memotechplus: design and drawings)

2.1 Drawing format:
Formats usuels

Les formats se déduisent les uns des autres & partir du format A0 (1 m?) en divisant le plus grand
coté par deux.

Le rapport de la longueur sur la largeur est de N2

Les formats peuvent étre utilisés horizontalement ou verticalement.

A0 1 SESREE===N n 210 % 297

841x 1189
[' S=SICEERE 420 x 297 E

A2
420 x 594

|

Indications portées sur les formats

= T = ™ 5 o e 1
([ Cadre intérieur :

~ il délimite |a zone de dessin; |

- — il est situé & 10 mm du bord de 4
la feuille sur les formats A4, A3 et

Syatbme de coordonnées : A2, a 20 mm sur les autres formats.

il permet de localiser rapide-

ment un détail :

— lettre pour la largeur; 3

— chiffre pour la hauteur.

_“ Repéres de centrage :
ils indiquent les axes de

symétrie du format
Repére d'orientation : g
il indique le sens d'orien-
tation du dessin (un seul).

Cartouche :

1) il donne les informations
Graduation centimétrique : utiles sur le dessin.
de longueur minimale & 200 mm

4 et _de hauteur 5 mm, e!le est . =] omargos:
utilisée en cas de réduction ou 2 7 e
d'agrandissement du dessin. —

T —. ——. = T
W @ Vil B

2.2 Inscription cartridge:

Emplacement

Lorsque la feuille support du dessin est examinée en hauteur pour les formats pairs (A0, A2, Ad) et en
largeur pour les formats impairs (A1, A3), le cartouche d'inscription doit toujours se trouver, en sa posi-

tion de lecture, en bas et a droite, accolé au cadre extérieur du dessin (NF E 04-502).

Dimensions
Le cartouche ne doit jamais dépasser en largeur
190 mm et en hauteur 277 mm.

Dispositions et contenu

180 mm

Symbole de la disposition des vues

&

170 mm maximum

o
]

| 20001009 |

| 20000102 | 0
1999 1204 [}

o ‘

| —— 04 |
2001 03 04 [ |
02 |

1

1

MATIERE | MASSE ‘NUHMES; INDICATIONS PARTICULIERE!

A ST GO6 _Aiodiseduren‘sonm
ECHELLE
11 COMPRESSEUR

I G Cylindre

S| SYMBOLE

Société A&D

Les Cotteaux - 54550 BAINVILLE SUR MADON

A2 } 1.35.10.52.448.014

0 cadre du dessin

ol
' 00 |« bord de la feuille

indices de mises éjnurT r

[] | — Dates _Noms Etablissement A&D DESIGN
Dessine | | = 54000 NANCY
Viérifié
- e SE— - 2 345678
: _| Homologué
— ECHELLE
| MANIPULATEUR
4 @ ‘ Bras
05
04 — -
= CIRTES i
o1 29 bis, rue d’Hellieule - 88100 ST-DIE-DES-VOSGES 0
Moo | e e callnn]
MISES A JOUR 2-100-2587-321 |
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2.3 Definition nomenclature: (memotech)

Elle peut étre disposée sur une feuille indépendante ou sur le dessin lui-méme. Elle peut contenir autant
de renseignements qu'il est jugé utile d'y porter.

Format A3 Eormat Ad
) T et
Perforations e = : .
(facuitatives) ST [PRER
selon la norme .
NF Q 09-001 I

2.4 Scales: (memotech)

Désignation Inscription

Indiquer toujours I'échelle & I'emplacement
prévu dans le cartouche.

Echelle 1 : 1 pour la vraie grandeur
Echelle X : 1 pour 'agrandissement
Echelle 1 X pour la réduction

Désignation particuliére

Echelles recommandées

(*) Ces échelles ne sont pas

s 8 s i | recommandées car elles peuvent
200: 1 250:1 500: 1 1000: 1 donner lieu a des impressions
Echelles z : " . trompeuses a la conception.
Tagrand t] 20:1 25:1 | 50:1 | 100:1
2:1(| 25:1 B 10:1 Nota :
= — Seules les échelles en caractéres
Vraie grandeur
(échelle me:ommamea) 1 gras ont été retenues a I'lSO.
B T e . " — Pour les dessins s'incorporant a
i K R 1z8 Li, P batiments, se référer a la
Echelles _1_:_ 20 1:25 17 :75077 71 : 100 norme NF P 02-002.
deréduction | 41.200 | 1:250 | 1:500 | 1:1000
1 1:10000

$2000 | 1:2500 | 1:5000

2.5 Element markers: (memotech)

Spécifications générales

— Les repéres sont attribués de fagon successive a chacun des éléments composant un ensemble.
— Tous les éléments identiques d'un méme ensemble doivent étre identifiés par un méme repére.

Représentation

- Les repéres sont composés de chiffres arabes. lis peuvent étre
complétés par une letire majuscule (8A, 8B, 8C...);
— utiliser des caractéres de plus grande hauteur d'écriture que celle
utilisée pour la cotation par exemple ;
- inscrire chague repére a l'intérieur d'un cercle (ou comme indiqué
ci-contre);
- disposer les repéres en dehors du tracé général des éléments
concemes ;
~ adopter un ordre déterminant :

- ordre numeérique,

- ordre de montage possible,

- ordre d'importance (sous-ensemble, piéces principales, piéces

secondaires...),
- tout autre ordre logique.

wld k]

Q ® PP 066
! A ad #

E_I'mﬂlgl

1. Partie motrice

2, Cloche d'embrayage
4. Electro-aimant

5. Disques intérieurs
6. Armature mobile

8. Fourrure amagnétique
9. Disques extérieurs
10. Bobine fixe

11. Bagues collectrices
12. Poussoirs de rappel

7. Ecrou de réglage 13. Accouplement élastique
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2.6 Arrangement of views: (memotech)

Dénomination des vues

Méthode de projection du premier diédre :
- Vue suivant F, = vue de face

- Vue suivant F, = vue de dessus

- Vue suivant F, = vue de gauche

- Vue suivant F, = vue de droite

- Vue suivant Fy = vue de dessous

~ Vue suivant Fg = vue d'arriere

Positions relatives des vues

Par rapport 4 la vue de face (F,), les autres vues
sont disposées comme suit :

- celle de dessus (F,), au-dessous

- celle de dessous (F;), au-dessus

- celle de gauche (F,), & droite

- celle de droite (F,), a gauche

~ celle d'arriére (F) peut étre disposée a droite de
(F,) ou & gauche de (F,), indifféremment.

Vues particuliéres

La flache indigue le sens d'observation du dessin,
par exemple lorsqu'une vue ne peut étre disposée
dans sa position normale.

Vues partielles

Si, dans une vue, la représentation de la totalité
d’'un élément n'est pas indispensable & la com-
préhension du dessin, la vue entiére peut étre
remplacée par une vue incompléte (voir dessin de
la biellette ci-contre).

Vues locales

A condition que la représentation ne soit pas
ambigué, il est permis de se limiter a une vue
locale a la place d'une vue compléte,

Les vues locales doivent étre dessinées en trait
continu fort et doivent étre relides a la vue princi-
pale au moyen d’un trait mixte fin.

5/ T

v =
; o i
YL f
— F L

Correspondance entre les vues

| AT = = I s 2 1 .
m
A ] ;
i -(___ ¢ lignes de rappel
c b
" m :
F4 F1 F3 6
| - | |
IR0 | H | &
) : : | ; i ; |
1A A oA A A A |,
F2
J| i droite a 45° !

- ]
BRIDE DE SERRAGE

JA,J-*.,., 3 T -—

Plan de projection (P)

kT

Les vues, construites a partir des plans de projection perpendiculaires entre eux, sont alignées les unes
par rapport aux autres.

On définit les trois régles de correspondances suivantes :

= Correspondances horizontales
Une dimension verticale sur la vue de face (exemple a) se retrouve verticale sur les vues de droite, de
gauche et d'arriére.

- Correspondances verticales
Une dimension horizontale sur la vue de face (exemple b) se retrouve horizontale sur les vues de des-
sus et de dessous.

- Correspondances en équerre ou a 90°
Une dimension horizontale sur la vue de gauche ou de droite (exemple ¢) se retrouve verticale sur les
vues de dessus ou de dessous.

Remarques

— Les lignes de rappel et les droites a 45° sont des aides efficaces lors de la construction de I'esquisse
du dessin.

— Les cotes A et B indiquent le positionnement des vues dans le format. Elles se déduisent des dimen-
sions « hors tout » de la piéce.
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2.7 Cuts and sections: (mémotech) Sections rabattues sur place ou sorties Demi-rabattement
Coupe par un seul plan Coupe brisée a plans paralléles
22 A-A
2 =
W iz A o e
; ’l i r ; '
wod e - —1— — - — i
el P8 d
£
/
/ La section rabattue sur place doit étre tracée en trait fin Coupe dans I'épaisseur de la nervure mais non hachu-
continu. rée.
Lintervalle entre les traits ! Sections sorties successives (deux localisations possibles)
des hachures est fonction de Pour les surfaces impor-
la grandeur de la surface a tantes, les hachures peuvent Interrompre les hachures
hachurer. étre réduites. pour placer une cotation.
Sections de faible épaisseur
Les sections de faible épais-
seur peuvent étre noircies ou
grisées entiérement. Ménager '
entre plusieurs sections conti- ERBSeS
ués noircies un espace ! ’ z
glanc. P | | (sections de l'arbre)
Surfaces planes Parties situées en avant du plan de coupe
Coupe brisée a deux plans concourants Demi-coupe Coupe locale
A_A
| r- @
/ Si la représentation de parties se trouvant en avant du
plan de coupe est nécessaire, les dessiner en trait
Surfaces planes en général Méplat sur cylindre mixte fin & deux tirets.
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Cuts and sections: (continued)

Vues de piéces symétriques

o/

[
-

Dans le but de gagner du temps et de la place, on peut représenter les piéces par une fraction de leur
vue compléte. La trace du plan de symétrie doit étre repérée a chacune de ses extrémités par deux
petits traits fins paralléles perpendiculaires a |'axe.

Vues interrompues

Représentation simplifiée d'éléments répétitifs

creuse.

2.8 Conventional hatching: (memotech)

Tous matériaux et alliages, sauf éven-
tuellement ceux prévus ci-dessous.

Cuivre et alliages de cuivre.

Métaux, alliages légers et magonnerie

Antifriction et de fagon générale toutes
matiéres coulées sur une piéce.

Plastiques, isolations et garnitures.

Bois en coupe transversale.

b}f Bois en coupe longitudinale.

Isolant thermique.

Piéces d'optique (voir norme

" A
{424 42) NF S 10-008).

e

g e
L !
T; ) "'“"._ + '—"_+_'f_@' w’r(]li l:ﬂm
e | A\li%\\
i | YT
T i e  —— e
t

Pour gagner de la place, on peut ne représenter
que les parties d’'une piéce longue qui suffisent a

la définir.

Position des usinages

2.9 Folding of drawings (A0-A2):

Iwischentalte

—'-j g‘u -

29

293

Pour la représentation notamment des liquides, du sol naturel (roche), du sol aménagé, de la mousse
de calfeutrement, voir NF P 02-001.

August 2010

Béton de masse ou de propreté.

E Sol naturel (meuble).

Verre fritté (voir norme NF E 04-117).



Machine Translated by Google

Introduction to Computer Aided Design (CAD)

EPFL

3. Introduction to the different Catia software tools

F1 key : Access to Catia help (you need an internet connection to access it)

The main workshops are:

Part Design

Design of 3D parts.

Sketcher
2D sketch drawing

Drafting
2D drawing

Assembly Design
Assembly of parts.
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3.1 Part Design

The Part Design workbench allows you to create 3D parts. The generated files are products with .CATPart extensions.

Boussole

Presentation :

i°°  Outils de

.,/ construction
e
Arbre: a
Historique de o
la construction H
4
a
al
o
<
&
e
m.
©
= "

) w Icones
Outils % cachées
d'enregistrement -
et graphique B
Ligne de ____..A-_“-»—-ﬁ,.;i?m g e mA MEN29350008 B3 580 6LUVIO paS "E
commande Plan et vecteur de référence

Handling : Translate the piece:

Rotate the part :

Zoom :

August 2010 -10 -
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Toolbar: (Only the most used tools are shown)

E& Sketch

Components from a sketch:

Extrusion Poached

Extrude with drafts and fillets Pocket with drafts and fillets

Multi-extrusion Multi-pocket
Revolution Throat

Hole Rib

Groove

RRNEISE

Back smoothing

2REISEaE X

Multi-section solid

Skin components:

By Edge fillet @] Chamfer

@ Variable leave @ Tapping
Processing Components:

fig Translation g Mirror

Uil spin $  Rectangular repeat
1 oo )

iy Symmetry %s  Circular repeat

Miscellaneous components

& Update « Point
Catalog /7 Right

Plan

Inserting a marker

T

August 2010 - 11 =



Machine Translated by Google

Introduction to Computer Aided Design (CAD) EPFL

3.2 ”%; Sketcher

The sketching workshop is inserted in the part design workbench, it is selected automatically when a sketch is made.

Qutline tools:

QB Outlines @ Basic circles
D Rectangles O Circles by three points O Ellipses
O Oriented rectangles g-D Circles with coordinates u Parable
Parallelograms N i Tri-tangent circles ;_ls.g= Hyperbola

D) Oblong contours O Arcs by three points E Conical
Q Oblong arches @ Three-point arcs using bounds / Right
Q Keyholes (’ Basic Bows {f' Infinite line
O Hexagons (O Curves : Axes

" Points % Intersection
Operations tools:
r- Round g Projection of 3D elements neh Translation
(_ Chamfer % Intersection of 3D elements @ Spin

S o . . = i
’ Cutting elements g Projection of 3D silhouette lines '|;]* Scaling

= , 1
~ Cutting elements ﬂ;h Symmetry 'vf:} Gap
¢#  Eraser

August 2010 -12 -
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Constraints tools:

Q} Constraints from a Dialog
[Ji Dimensional constraints #]  Animating Constraints

Visualization of constraints:

Perpendicular 1 Fixed
. . s
© coincide ) Parallel
©®  Concentric “2Y Ray
W  Vertical LS50 Diameter
H Horizontal

Element colors in sketches:

White Fluent

Red Selected
Green Constrained
Purple Over-constrained
Brown Incoherent

August 2010 - 13 -
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3.3

Drafting

The Drafting workbench allows you to produce 2D parts. Generated files are products with .CATdrawing extensions

Arbre

Vue de
Face

|

I_!:

\

\\\&\\“\\\\% '

134

55

136

164

p2s5

TETIRET Y
Adm ator
DATE,

~ 1041942003 — 4

XX

> EEEFEEES

-.‘J E

: ’?T %-kn I 4@.1ﬁ1! .I %E} _1‘ ‘I:E‘

5B a .

R0 KO B

BeaQEE '@/

‘Selact an obyact o1 3 commard.

: Cartouche

August 2010
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Toolbars: (Only the most used tools are shown)

Cartridge Ld Creating a frame and title block % Creating a parts list

Views :

e Frontview g broken cup &2 Detail view with profile

?:E Unfolded view é@ Unfolded cup Setting up views with the wizard
;IE. View from 3D { Broken section qéé' Front, top, left view

Eigll 21 o s ) )

Projected view ﬁ;@ Unfolded section “’é‘l Front, bottom, right view

e - . . . e .

5 Auxiliary view Clipped view All Views

Isometric view Clipped view with profile

Quotes:

|
1;;;1 Odds l | Length dimensions g Chamfer dimension
?E%g Cumulative quotes :) Angle dimensions ﬁi Tapping dimensions
S Stacked dimensions b Radius dimensions .2, Diameter dimensions
Tolerances:
Reference S5 Geometric tolerances

-15-
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Dressing:

ﬁ)‘ Center line seen from the front without reference Thread without reference

Thread with reference
Center lines seen from the front and seen from the ends

Ei Center line seen from the front with reference

o

[]: Center line seen from ends

Notes:

T Text

/l Attached text

Roughness symbol

Weld symbol
Welding

P s

Tr Copy of text
@ part number

e Partial reference
Bl Table

'@ CSV table
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3.4 Assembly Design

The assembly workshop allows to assemble already existing parts or to create parts from this workshop. The generated files are products with .CATProduct
extensions.

i e s Outils
Arbre = d'assemblage
de piéces

essort (Rondelle_ressort.1)
le_ext {Couvercle_ext.1)
tes
Applications

BEE BHOABECHRGER & dupyl ansprposgsl gl ol el

DEEG ey R LS EE RTEeRAQALRE0EE oty 'S/ s48 '@ /¢ ' gew ' | g z |
Séiactiornez un chiet ou une commands i ;_ql
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Toolbars: (Only the most used tools are shown)

Structure :
E3E A
“'- Inserting a new component 9«'33] Inserting a new part
T, . . .
: Inserting a new product [% Inserting an existing component

Constraints:

ﬁ Coincidence Fixed

@ Contact

:9 Distance

@ Angular

Relative fixing

Constraint command

Reusing a pattern

Constraints on the assembly: Symbol in the tree

ﬁ Coincidence —* ) @ Angle —* ,
5 y
@ Contact —* H g Parallelism > |

L] -
- ‘r - $ To stare :

Gap

=

Perpendicularity

August 2010 -18 -



Machine Translated by Google

Introduction to Computer Aided Design (CAD)

EPFL

4. BASIC EXERCISE 1: 3D DISK TREE

3] ARBRE DISQUE
== Plan xy

.= Plan yz

=27 Plan zx
T‘& Paramétres
==3 Corps principal

Keyway

W 34CrnNiMos

? Extrusion. 1
2\ Esquisse. 1

-? Extrusion.2
iy
;&% Esquisse.2

Extrusion.3

ke
squisse. 3

F? Extrusion.4
A Esquisse.5

'? Gorge. 1
£ Esquisse.4

5

r@ Poche. 1

—@ Chanfrein.5

o) Reoétiion crauia

*Matériau* =34 Cr N Mo 6
—@ Set géométrique. 1

Throat R1

Rolling support @ 30

Range @24

FINAL RESULT

Range @25

6 M6 tapped holes

Range @38

August 2010
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unl

BN
Note : the symbol "double click on the left'nmeaadidlick 'once with the left mouse button”; 2x In this document, " means

Start Menu > Part Design > enter part name: DISK TREE > OK
File menu > Save > (default location, or as indicated) > file name: DISK TREE > Save

Creation of the span & 38 mm length 28 mm

[ o D 7

" ZX plane in tree view > b E—’v SKETCH

O . o

" % CIRCLE > place the center on the origin = approach the origin with the
cursor until the symbol appears @ (coincidence between two points),
| s BN

L

to set the center > circle " anywhere in the window to put the
of any diameter.

The circle is red, indicating that it is selected. Otherwise (white circle), select it :

|_B8 K1 S :
~ BL CONSTRAINT > set dimension (" anywhere in the 9 Arbre disque DEfinition do.Lexiriion
BN < Plan xy
window) > 2x  — on the diameter value, enter 38 > OK < Plan yz
< Plan zx
o . -@Corps principd
./ E3 LEAVING THE WORKSHOP =-7 ) CEISRaN ProfifSuface
@Esw'l Sélaction : [Esquisse. 1 Z @I
L2 @' _ [ Epaissir
\_/ EXTRUSION > Type: Length > Length: 28 > Selection: Pl 2o |
select the last sketch created, here Sketch.1 (if not already [ Extension symétrique
selected by default) > OK inverser la dection
Phus>>
Face to select as sketch plane @ ok | @ annuer |
for next step -

August 2010 - 20 -



Machine Translated by Google

Introduction to Computer Aided Design (CAD) EPFL
Range @ 30 mm for bearing support Définition de fextrusion  [)fK)
Arbre dsque Premsre kmite
. i i —
~ face of the @ 38 span that we want as the sketch plane ‘__I_Hm:x e
(see figure p 20). The contours of this surface turn red. - Corps prcpd i J
Pr oe
b Pl s o
L sKkeTcH =) extnsion2 e
{F Esquisse.2 R ——
[] Extenson symétriqus
m .:D -I] . Irversar |a drection |
~ @, crcLE > center’on origin > any (circle -~ diameter : =
turns red)
lo ok | Danenier| speru |
- . . i :
CONSTRAINT > set the dimension > 2x-on the diameter value > enter 30 > OK
KD 4

./ E3d LEAVING THE WORKSHOP

[ 8
EL EXTRUSION > Type : Length > enter 2 > select the last sketch created (if it is not already selected by default) > (reverse the

direction if necessary, so that the extrusion is indeed created outside the solid already existing)
>0K

Note : to display the object (either the sketch or the 3D object) centered on the screen, with an optimal zoom, several solutions:

- Press the key Home || of the keyboard

- View menu > Center All

| an
-/ [ CENTER ALL (bottom of screen)
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ketch plan
Range @25 mm length 76 mm fsoregczspn?me P, — =
extrusion Type:  [Longusws ~]
- . : s [ 1
~ the face of the cylinder @ 30 that we want as a ‘Arbre dsque e
sketch plane f—‘*’::W ProfiSurface
Z . ————
ID J j‘F‘imZX [_S;i:::;;Emssea E—”’J
s ®-§3 Corps prncpal =
Y SKETCH $?Exum1 ]
Esquisse. 1
ID @ -:I:] ﬂ:] ?Exuugon 2 Inrverser s drection |
~ % CIRCLE > center on origin > any diameter -~ T Phs>> |
(the circle turns red) "@m L @ Arender | _apersu_|
EL . . m . =
CONSTRAINT > set dimension > 2x 7 on >\
the diameter value > enter 25 > OK B

./ I'TJ LEAVING THE WORKSHOP

@v EXTRUSION > Type : Length > enter 76 > select the last sketch created, here Sketch.3 (if it is not already selected by
default) > (reverse the direction if necessary, so that the extrusion is well created outside the already existing solid) > OK

Note : Practice moving the piece using mouse shortcuts (see page 10)
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Range @ 24 mm length 58 mm

|_BN
N/

face of the @ 25 cylinder that we want as the sketch
plane

KD 2
T SKETCH

O ocrees U iof -
- center on origin >

any diameter (the circle turns red)

- CONSTRAINT > set the dimension > 2x on the
diameter value > enter 24 > OK

| BN
~s r’b LEAVING THE WORKSHOP

|_BN
e @, EXTRUSION > Type : Length > enter 58 > select last created sketch (reverse direction if
necessary) > OK

Note * remember to save your work regularly (Ctrl + S)...
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Throat @ 22 mm:; R 1mm

[ P T T T T LT LT TRy S E RIS SRS pE. TSRS P

C U H SKETCH

YZ plane in tree view >

----------

E-]/] @ CIRCLE >

- =4 the center anywhere (for better

ol

visibility, outside the room) > any diameter.

next to the circle (the circle turns white)

—-' Entfi of Spah 1%}

T

Range @ 24 24

©

on the odds value >

!_]/] EL CONSTRAINT > E‘]/]end of span @ 24 > = circle center > set dimension > 2x
enter 51 > OK

!—]/] E}v CONSTRAINT > FB EE}

on the axis of the scope & 24 > the

center of the circle > set the dimension EI/]OH the odds value >
> 2x enter 12 > OK

B

E}' CONSTRAINT > circle >'Set dimension > 2x diameter value > — on the
enter 2 > OK

@ ﬁ‘ LEAVING THE WORKSHOP

@ @ GORGE

First angle: 360 deg, Second angle : 0 deg > Profile/Surface, Selection : last
sketch created (Sketch.5) > Axis, Selection :

. the axis of revolution of the @ 24 span > OK
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Keyway on @ 24 seat

Creating the key outline using two arcs and two straight lines.

A\
EI/] XY plane in tree view > !:—9 |__L SKETCH

o @ ODAODE
* il
~ 8 * ARC (hidden behind the CIRCLE symbol | )>

where on the staff axis @ 24 for the center (the symbol appears when the @buse

passes on the axis) and ~ 2 points for the ends of the arc.

@

EEJ (.', CRA >

anywhere on the staff axis @ 24 for the center (symbol ) and

©

Etape 2

anything

© -~ 2 points for the ends of the arc.

Note : in some cases, you may not want to create automatic constraints such as the coincidence constraint represented by the symbol. .In this case, the Shift button must

be held down while the sketch is being made. ©

E] /v RIGHT > draw two lines connecting the extremities of each of the 2

bows. To be sure that the extremities of the straight lines coincide well with the extremities of the

arcs, bring the mouse close enough to the point to see the symbol appear.
@ before clicking on the left to set the point on the line.

Keyway Stresses & Dimensioning

©

red) > release the Ctrl key.

E] HI SELECTED CONSTRAINTS IN A DIALOG BOX
enable Verticality > OK

on one line > keep the Ctrl key pressed and on the other line (the two sélected elements tumn

Contraintes

x|

[[] pistance [ Fixe
[] Longueur [] Coincidence
[] angle O conce

0O

iarand 2 [ parallélisme
cmipent 2ve [ Perpendicularité
crie D: lzoncalice

I3 verticalité

-25-
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“~" on a straight line > keep the Ctrl key pressed and on an arc%tﬁe two selected elements turn
red) > release the Ctrl key.

EI; &l SELECTED CONSTRAINTS IN A DIALOG BOX
enable Tangency > OK

Repeat the operation until the 4 extremities of the lines are tangent to the arcs (the symbol must
appear fai each tangency).
[ 38 [ 8
B CONSTRAINT > gend of span @ 24 > “~ nearest arc > place the
odds > 2x E] on the dimension value > enter 5 > OK

“an T T
s Ejv STRESS > dimension ' abow > “~ the other arc > set the dimension > 2x !—:9 on the value
> enter 40 > OK

| 8 | R |
o EL CONSTRAINT > - aline > “~ the other right > set the dimension > 2x © on the
dimension value > enter 8 > OK

IMPORTANT: If the ends of the lines and the arcs do not coincide:

© on the end of the line > keep the Ctrl key pressed and (the two © on the end of the arc
selected points turn red) > release the Ctrl key.

EI/]' %I SELECTED CONSTRAINTS IN A DIALOG BOX >
activate Coincidence > OK

Repeat the operation until the curve is closed.

LBy fa

i :
% M NP (T,
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IMPORTANT: NOTES - The

sketch is fully constrained if all the lines are green - If some lines
are white, the sketch is not fully constrained: the entire sketch must then be constrained by setting the missing dimensions and constraints.

- If some lines are in purple, the sketch is over-constrained: the over-constraints must be eliminated as-saon-as they apnea L

(=

EIJ LEAVING THE WORKSHOP

B pockers U Bzl

First Limit / Type: Until Next >
Second limit / Type: Length > Depth: enter - 8 > OK

Définition de la poche

Note - When no second limit is entered, the pocket starts from the
plane chosen to draw the sketch (in this case, the XY plane located at
the center of the part) up to the First limit.

@ Perpendcudsire au contour

When you enter a positive value for the Second limit, the pocket Dm o R:f;:“;"aé’;ﬂg
starts before the sketch plane. O o
When we enter a negative value (our case) for the Second limit, the zot lo drection =]
pocket starts after the sketch plane. sou O O

= D noner | _tossy|
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6 M6 tapped blind holes

' @ HoLE

©

face in question appear (see page 10)

face of the @38 span (the hole appears in red), if necessary rotate the part to see the

e green arrows of the hole (hold down the button) and move the hole so that it is no

longer in the center of the room.

@

B

" Type tab : Simple

@

tab : Thread definition :
activate:
Threaded Type : Metric
Coarse Pitch Ref. thread :

M6 Prof. thread : 10 mm
Depth. hole : 15 mm

Enable: Not straight

-’ Extension tab >
'z
> g Editing the sketch

Extension tab : Blind > Bottom : V -shaped

Face chosen

to place the
hole

Définition du trou

[ Extencion | Type | Définkion &y taraudage |

Définition du trou

Extersion | Typs | Défintion dutarsudage |
5 Tarwust
Deéfindtion dhu tarsudage

Type: | Métrigue Pas Gros
Ré&F. varaudage: ]Mﬁ

Pasi T E®

@ Pasdeot ) Pas gaiche

D o | 9 senier| tpepy |
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©

vertical axis V > hold down the Ctrl key > Ctrl key

©

EI/] i SELECTED CONSTRAINTS IN A DIALOG BOX

©

© B CONSTRAINTS >
2X cgﬁl]}odds value > enter 14
FJ] tha LEAVING THE WORKSHOP

ok

Circular repeat

e Hole.1 in tree view (hole
turns red)

EI/] {}v CIRCULAR REPEAT
EHox

(rear

@ tab: Axial reference
Parameters: Whole Crown

Instances : enter 6

Reference direction : e the face of the

@38 span enable: Keep
specifications

>0K

Coincidence > OK (the symbol app&rs)

(If needed Plus and Toggle)

the horizontal axis H > e on the point > set the dimension >

> okay

dot (both selected items turn red) > drop the

Définition de la répétition circulaire 9 X
Référence axisle | Défition dune couronne |
Paramétres: |Couranne ertiare -
Instances : 3
Espacement anguare : [ = F A}
Ae total B =27
Direction de référence
Elément de référence:|Extrusion. 1|Face..
nversion de s drection |
Composant & copler
Composant : |Trouw.1 !I
I3 Canserver les spécfications
Bus>> |
- D ok | Sancuer| aperu |

August 2010
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8

Chamfer 0.5 x 30° \\k j“

F—E edge to be chamfered (the edge turns red)
(do not hesitate to zoom in to select the edge)

© & CHAMFER

Chamfering edge

Définition du ehanfrein

Mode: [Lorgumr 1 jangie -
Longuewr ] : |0,5m
Ange: | 30deq
[T RE N Bl R épétiion croulare. 1A
Propagation: | Tangance -
[ Irwverser

Mode: Lengthl/Angle
Length 1: enter 0.5
Angle : between 30 > (reverse direction if necessary) > OK

(O ] Samie| - |
Bibliothtque (Leciure seule) :‘: &
APPLICATION OF MATERIALS . Bl ojo
Accortncton | A amblration | Ac chmentation [ ntruration | Acoutls | Acnocpdabies | Fortes grves [Fortess | |
- =
@ E} APPLICATION OF MATERIALS
© Ac improvement tab > © 34Cr Ni Mo 6 n n n I
!:D MHMOaONME 42O Mo4Y <=9 100 42CrMo4V > @ 100 51
~“ Main body in tree view (part outline
turns red)
!:D . 679Cr5 85 Cr Mo v7
- Apply Material > OK E E
ETG 100 S400
File menu > Save =
| | |
[ Ui s Fichier
- = o« ] | Fermer |

August 2010 = 30 -



Machine Translated by Google
Introduction to Computer Aided Design (CAD) EPFL
Note The
tree was made by drawing one staff after another, we could have drawn it in one step using the revolve function .
Start menu > Part Design > enter the name of the part: TREE DISK 2 > OK
File menu > Save > (default location, or as indicated) > file name: TREE DISK 2 > Save
[ 88 K 7
" YZ plane in tree view > 5 skeTen
""""" U S S I S W S "0 A A N S S N I I SR S S R
s = ‘ e
,,,,,,,,,,,,,,,,,,,,,,,,,,,,, (VO P 1 ISR SRR S ff‘*
| : i :
m H [ ] 5\ s '
v A _uﬂ? 5 ; -
PN v 12 25 5 19
: ;R T8
_____ _H 3 : lo b Y ;
Using the drawing tools, draw the half-profile of the tree and set the necessary dimensional constraints. _
s 2y - o 7 _ K g
Help: the “outline” icon allows you to draw the outline in one go ; 2x " © = keeps the icon ( ~ © = for the
ﬁ}, )

deactivate), this function also works for other icons, such as

-31-
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E_]/] ﬁ'l LEAVING THE WORKSHOP

!-]/] W REVOLUTION

Axis > Selection: select the axis of revolution (the H axis) > OK

Définition dune révolution |7 'S(

Lestes

Promer ange: [HEST 5]
Secordange: [0 1)
ProfliSustace
mm:—@

[ Epsssn e peoft

e

L)
Slaction : [[sasssa, 1\irite

Bz
ﬁ_lﬂ' 3 o | ooy |

We thus obtain the disk tree in a single step. All that remains is to draw the holes and the groove as before.
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5. BASIC EXERCISE 2: 2D DISK TREE

-
_N
—T
_.m
_c.n
»
~
Qo

-0,02

o
o 738
| B30
Qa
>
P>
qa
=
)w
L/ \
wn
n? [s2]
y
8 N9
0

c 40 5
51 .
— KL A Wl r Detail B, 5:1
i Iy Ra32
. = |J4 ( )
% 1 5 Demre 24.06 2009 Jennifer Gasparoux Ectube
2| - b . )
N Chanfreiné 0,2x45° — — — EI@
Tolérances générales : = T A4 I 1 1
NF EN 22768 - m p——
F (ISO 2768 - m) ARBRE DISQUE

FINAL RESULT
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File menu > New > Drawing > OK > Standard : DETAIL_ISO_R18 > Sheet style: A4 ISO > Landscape > OK
File menu > Save > L: catia > file name : DISK TREE > OK

Standard
[DETAILL_150_R1S |

Taille papier = 210,00 x 297,00 mm
Echelle globale = 1:1

O Portrait

T T TR T
oed oI ] - e Tl

"] Paysage

[] cacher en démarrant ['atelier Drafting

[@ ok | @ annuler | 1

- /|
s
:::J

E’.

File menu > Open > L: catia > g
- ;
—" DISK TREE.CATPart > Open a

o Pl £ - 1:

Window menu > Horizontal Tile o e . =
®» |5

.-

Two windows are then visible on the screen: - the -
drawing or 2D window - the part or 3D 7

window i &

~,

o
DEUd B W Lo M4 FHRARE N snuX 20 © on ‘}'-:-...
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!:D -:I] =l o
“~ In the Drawing window and " | " FRONT VIEW .

%00

XY plane in the 3D window: the selected view is

displayed in the 2D, Using this small element, Rotate 3
the part of the 2D window so aM o
orientation of the figure (keyway visible) . |

Deld B W Lo RADE THNARE oW o e ¢ oM 4l

..
“~ (Hold) the view frame and move the part in the layer to the desired location.

- next to the view to confirm the position. P,
Now, for better visibility, minimize the 3D window and enlarge the 2D window so that _~
it takes up the whole screen. |

. o _ H— = -
Note : To change the scale of the drawing, > on the red frame of the drawing = .

Properties > View tab > Scale > enter the desired scale > OK. (in this case,

you have to work on a 1:1 scale, which must already be the case) :

4US B @ Ly WARE PELAES um sl - N8 O ON e
S et i il AR e |
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To insert the cartridge:

| .8 x
— [ CARTRIDGE CREATION > The A4 cartridge appears with the
name DISC SHAFT. I—
] I 00
~ =y Q- -0
3 n | 0/
To modify the title block, " EPFL_Drafting tab , then twice on the ¢
- —111-
box of the title block to be modified. To come back, ~~ Layer tab.1 . L
Ko | go ]
| ®'~ PROJECTED VIEW (behind FRONT VIEW) > place the view to — =t ———
the right of the room. : — e ]
- —— ' Ad | 1
MDBQUE §
D
b Ezﬂv BROKEN CUT ‘
!:[-1 E:I_] 1 2 3 ¢ 5 6
" On the horizontal axis of the front view (on the left of the part) > 2x on the ‘axis .
(on the right of the part) > lay the cut
o 1A _’. A 5 0
| o I | | . J-l o -i-o
Hide the letters A indicating the cut: on the elements in question > o o
(o ‘
hide/show (or ~ on the element > space bar) ) =52
Note- to retrieve hidden items: J Q- ., . iy
View menu > Hide/Show > Show Hidden/Shown Objects
Then on thé object and hide/show. H -H -
To return to the displayed objects: View == S A2
menu > hide/show > Show hidden/displayed objects R ARBRE DISQUE
oo
wee — ONtheicon located at the bottom of the screen)
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Checking links: File menu > Desktop (the two linked documents are side by side)

Tools menu > Analyze > Show Geometry in All Viewpoints

B & ® ) arere DIsoUE.CATDrawind — 3§ ARBRE DISQUE.CATPart

close office

[E ARERE DISQUE

=2 ] Epfi_Drafting
T3 FRAME_LANDSCAPE _A4
T35 TILEBLOCK

Fenétre 3D

4 Animation

=

7
|
z
.
|

==

-
-

|

oy

==

=

==

|-

ARBRE DISQUE

Drag the cursor over the different views of the 2D Window and observe the highlighting on the 3D Window.

Close the 3D window.

August 2010
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IMPORTANT : before dimensioning the figure, select the frame of the view you want to dimension > the working frame turns red.
FRONT VIEW DIMENSION
= Calque.1 | Epfl_Drafting |
Keyway £
J £ £y &) B3 B« ) valeur : |10mm ®
€D
" "% QUOTATIONS °
o || { It e——+—
— leftarch
A
<=
KL
~ right arc vZw
< 3 .
Hold down the Ctrl button and point the mouse at one of the yellow i C‘_:__ I .. O B | - i< . o
diamonds. (The positions 1 2 3 4 indicate the anchoring places of the % : L0
dimension line). ﬁ 3%
With Ctrl still pressed, you will ~~ (and hold) one of the yellow diamonds that v 3\2 x o
navigate to #4 (outside the groove) a
Turn let go and do the same with the other diamond.
L s !
~ next to the view to confirm the position of the dimension. ( )
Proceed in the same way to dimension the distance (5) from the key to the end. 40 -+
- ———
-38-
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v
0
@_‘
KD o . 1y
' % QUOTATIONS o L il -
f o4—-o
L '
“~ The two parallel lines > Set the dimension
40 5
BN

“~ next to the view to confirm the position of the dimension.

Note : when defining the dimension, to prevent the writing from following the mouse
cursor, press Ctrl when selecting the surfaces associated with the dimension.

\ | Sélv:hun:E
)I’ " Valewr  Tolrance Ilwdo(otu | Ligne do rappel | Textes del
Yalewr principale Valeur dusle
© [1owroL et +| © (108 (pas de totsr - |
@ volour suphriewre: [ o -] [ =]
on the previous dimension (8) > Properties > Tolerance tab el B =
> Main value: 10H7 TOL_ALP1 Premibre valowr : N9 ~] & -
> First value : N9 (enter this value manually) > OK Seconde valewr : |BI B -]
- o
" next to the view to confirm the position of the dimension. =
©

o e
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Execution of horizontal dimensions 58, 134, 136 and 164

|_B
N @v STACKED QUOTATIONS (behind quotations)
|_BN

“~ the shaft end line (which will serve as a reference) >
| L | B
" the first edge to be dimensioned (58mm) > “~ the second edge to be dimensioned (134mm) > " the third edge to be dimensioned (136mm)
1]
> - the last edge to be dimensioned (164mm)
|

Set dimensions > “~ next to the view to confirm the position of the dimension.

| |

]

2

8 N9

' L‘"’ 5

Note : Subsequently, it is advisable not to use the Stacked dimensions option. This option does not allow you to modify or delete a single dimension, you must

delete all the stacked dimensions and redo them.

- 40 -
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Execution of vertical diameter dimensions @24 0/-0.02, @25, @30, @38 0/-0.02

D & 5 Propriétés @@
~~ % DIAMETER QUOTATIONS (behind quotations) e -
- Valeur | Tolérance |Lignedecate [ Ligne de rappel |Textesde!a co 4[_{
-:m Vaie;;grhciggle - Vala:rdl.:ee —
" the @24 diameter edges > set the dimension > il - RS2 IR 0 om o
Waleur supérieure : |0 mm ~ | ~]
@ on dimension > Properties = Valeur inférieure ; |-0,02 mm = | -]
[T ] = Premigre valeur : |E J ﬁ _I
*~ Tolerance tab > Principal Value: select 10-4 *© = Tl 2] -] = =]
TOL_NUM2 > Upper value : enter 0 > Lower value : enter - 0.02 > ot A
OK - - T 3
a
40 5 t
In the same way, carry out the other dimensions of diameter @25 0/-0.02; @30; @38 0/-0.02.
164
58
[+>]
=
[ = r
= E- gT t $ = E
= [= : ' ~
LS l LS
| i 3 = 40 |5
2‘
LS8
-4] -
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136
N 134
@ El, REFERENCE -
o -—
- o 8
~~ the upper line of diameter @25 > set the reference > enter A > [ ‘ S '
okay o
o g %
Sl 1" r -
IS
I [
Execution of roughness symbols. ‘
K = 21| -
./ ¥, ROUGHNESS SYMBOL = a = Q vf
L | =
*~ the upper line of the diameter @25 (positioning of the anchor) /-_I—
—
1 [ M-—-—-—c=c==- m ]
—Y 14—
— Rétablir l @ oK ' aAnnuleII -
21|
- El

|_=N
Contact Roughness (Circle) or No > “~" symbol without circle

|Rugasité de contact (Cercle) ou Non}

| [
4\/'(4'

: Rétabir | @ ok | @ annuker |

-42 -
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Number or text > enter Ra 1.6 \

./ okay

Execute the other symbols in the same way.

164
136
- -
L 134
__/Ral - 58 " .
i ‘ Ra16 Ra16 -
™~ l o™~
-3lal s
. m‘ Ll |
S S " ' ~ |
8| | ! 8
1 - S 40 5 )
e o - -

-43 -
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CUP QUOTATION

KD
Activate section view (2x *~" on the Cup frame: the frame turns red)
Keyway depth
KL ey
' s QUOTATIONS
|_BN BN
" the bottom of the keyway > ' the outer edge of the shaft > Set the dimension
|_BN

“~’ next to the view to confirm the position of the dimension.

Dimensions 51, R1, @22 of the throat.

KD

" Yy QUOTATIONS

D )

“~ the shaft end line > “~ the back of the groove > Set the dimension.

-, N

=" next to the view to confirm the position of the dimension. 51

KD r )

e * RADIUS QUOTATIONS p

" the back of the groove > Set the dimension A A o il il e e Y
. L nd

" next to the view to confirm the position of the dimension. &
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Palette d'Outils

!:m I‘_’I o W v
. ./ Ny QUOTAT|ONS lForc, une cote verticale dans la 'ue]

& AT e
" back of the throat up. i I A
|_BN

AL -
“~ in Tool Palette > Force Vertical Dimension in View.
“~ back of the throat down.

7
Note - As explained previously: move the yellow diamonds to position 4, in order to obtain the desired
dimension 22

Ask the dimension

N - 51 .
Ay
o
[ L5L, J ’ <
. Wi [ 4 A
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O

dimension 22 > properties > tab Texts of the dimension > Prefix : choose the symbol ¥

22

91

7))
¥
Y ]

Y

[ e

" next to the view to confirm the position of the dimension.

Dimensions of the depths of the holes and threads M6

KD
-/ ™% QUOTATIONS

o,

the line of the shaft end and the edge to be dimensioned.

| BN

in Tool Palette > “~ Force a horizontal dimension in the view
e
> Set the dimension > " pext to the view to confirm the position of the dimension.
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Y i |
¥ TAPPING DIMENSIONS (behind DIMENSIONS )

~ a line of the M6 thread.

Dimensions M6 and 10 appear,

Position the dimensions.
N,
' e on d exte apre
{®) Texte aprés : [(EX)—L_|
dimension M6. % 1 5 a Annulerl

v
the red triangle after 6 > Text after > enter (6x) > OK @

@A @ E

next to the view to confirm the position of the dimension.

e ?7 / // V /////// ////,/E/{r/ ,/"/ /{ //
S "/ / i Fir. P4 i >
| 5554 s 41 s //://;/// _
= ; FAIHS IS LLIIENL LT IS -t

> _/ // /,IJ

25

15
-

-47 -
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1T m

'@ ¥
Tolérance géomeétrique

*~ the edge of the shaft end (positioning of the anchor)

KL @
./ v GEOMETRIC TOLERANCES:

Place the start of the geometric tolerance symbol.

| BN

In Tolerance, " symbol ” (single beat)

> Tolerance : enter 0.01
> Reference : enter A

>0K

Adjust position

|

N \ Tolérance

R o] —

=

|Caractéristique — “trique]

—~ Rétablir

{-- - &E§ \\

—=M-\

- ——— = Tolérances geoméirigues f'? ’g'
0 01 A 3 Fltrage des boble ances W«;MEJ

) = -

1 Tolér arvce Rl érence

4 foo 0 [ El

\\ | - : -
\\\ -+ o - 77ﬁ,j Ritaber | D x| 9|

L
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Modification of the anchor

In order to modify the type of anchoring of the tolerance, it is necessary to use the yellow diamond “ 5 , the

white circle and/or square 4

BN

hcd (maintained) the yellow diamond: it is then possible to move the anchor along the surface.

BN

i (maintained) the white square: it is then possible to move the square horizontally.

hcd (held) the circle: it is then possible to move the anchor on the box

N\ 4
" next to the view to confirm the position.
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LEFT VIEW DIMENSION

.
Enable left view : 2x " view frame (the frame turns red)

|
Modification of the center lines of the threads. @ @

_ [ 88
Erase all centerlines: " the centerlines to be deleted > press the Delete key on the keyboard.

Centerlines to erase
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-

KL 5
~ Mv THREAD WITH REFERENCE (behind @‘ )

) o Palett...
in Tool Palette > ' Tapping

[ o. . [ ..
- tapped hole circle > - reference circle (circle outside the part)

Do the same for all the other holes.
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!TJ o
-/ *7% DIAMETER QUOTATIONS
Rl

— circumference of the centers of the tapped holes > Set the dimension

~ next to the view to confirm the position of the dimension.

| B8
N~ ﬁ}v ANGLE DIVISIONS

- -

~~ horizontal axis > " axis of the tapped hole > set the dimension

[ &8

" next to the view to confirm the position of the dimension.
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Activate Front View (2x " on the frame of the view, which turns red)

] :
I,I #v DETAIL VIEW

| BN

" to set the center of the detail circle > ~ to set the size of the circle > set the detalil

Reposition if necessary the name of the detail (B)

134
98
B ~ = __ - L
\C_\ \_/7Ra 16 < ;
_— - - c:.?qﬂl
S
40 ]
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™ on detail frame > Properties > Scale ; enter 5:1 > OK

Propriétés @@

e —| Sélection : [ _I
Yue | Graphique ]
B Visualisation et comportement ~
4 Cadre de la vue
f [ verrouilage de la vue
£ [ recadrage visuel
k‘ ) Echelle et orientation
Rotation :| 0 deg Echelle :[5:1 =[5
— = =8 = =% | —}— 1 Habillage
\J [ Lignes cachées 'S Axe vudedessus '3 Spécificités définies dans le 30 [
d Axe 4 Taraudage - Filetage
4 Congés d'arétes W@ Limites des congés [Opaints3p: O
O arétes symboliques @ l
) Arétes dorigine [C] Eléments 3D filaires &
() Arétes dorigine projetées @)
Nom de la vue
Préfixe : Identificateur Suffixe
| Détail El
Editeur du nom avec formule
Editeur :| Détail B fi
. IR v
< >
Plus... I
‘ @ oK I @ appiquer | Fermer |
~ N N I
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Chamfer dimensions in the detail view r
. ! J
- -‘J \ :
Activate Detail View (2x “= on the frame of the view, which turns red) s 0 ,/
h D
KD jes A, /
' Ry QUOTATIONS N -~
~ -

Dimension the width of the chamfer.

B
\_/ ﬁ}v ANGLE DIVISIONS

K Ko

~ chamfer edge > ~ tree ridge
@ Angular sector > Sector 3

Ask the dimension

|_B8

“~ next to the view to confirm the position of the dimension.
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T et

| BN
~~ text position > Text Editor > Enter DETAIL B, 5:1 > OK
Adjust text position

| _B8
“~/ next to the view to confirm the position of the text.

a0

\‘ y,

N2 Détail B
0.5 51

T et

| B8
“~ text position > Text editor > Enter text below > OK . (to go to the line press Shift + Enter)
Adjust text position

|_B8
“~ next to the view to confirm the position of the text.

Dessind 17.11.2008 jennder gasparoux Ectele
L - — {1
B par g a @
Chanfreiné 0,2x45° e B — T
Texttoenter ~__,  Tolérances générales : | —————"—"———=—1— e — A4 1 1

S0 2768 m) " (PAWM~— AmBre DIsauE

N o9 desen

August 2010 - 56 -




Machine Translated by Google

Introduction to Computer Aided Design (CAD)

EPFL

Run General Roughness Symbols

E] V-v ROUGHNESS SYMBOL
“~ above the cartridge

Number or text: enter Ra 3.2

A Okay

® ¥ ROUGHNESS SYMBOL

| =8
“~ above the cartridge (to the right of the previous symbol)

Number or text: enter parentheses

S Okay

Adjust positions

| BN
“~ next to the view to confirm the position of the texts.

Chanfreiné 0,2x45°

File > Save NE EN 22768 - m

(IS0 2768 - m)

Tolérances générales :

Symbole de rugosité r'_)|r)_?|

Ca— g

G

T— g
[
L
/)
[
— —
I _J )
. _Réatwr | [@ o | @ anner|
/Ra3?2 \A
Lmnre 17.91.2008 Jerrier GaspAroux Ll
ot L3 j-"-“. 1 :1
— — El®
NoraroE e 3 =] wrem 3 Cr o Mo 6 Orgra T T T
Momerom s 3 W 5P D s 0.735 kg Sempace A4 1 1

- !" ARBRE DISQUE

N oo pwe
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-
[y
:)
:
(4]
»
~l
oo

136
134

-0,02

9]
- ?38
@30
E
P>
E
)w
0%
ﬂ% .
J
8 N9
@24 °

A
. /
— I ™
| L/
i ' A
\
C S 40 5
m.
(o]
LS

~| R B 51

ik

| E /=

-

©
— 1 5 Dessing 24.06.2009 Jennifer Gasparoux Ectale
= = = = 1
N Chanfreiné 0,2x45° e = — = ,.ul.j
Tolérances générales : — 00 v 0735 k: = A4 1 1
NF EN 22768 = m ) Déwwamration N 06 essin
F 1502768 - m (PR ARBRE DISQUE

August 2010 - 58 -



Machine Translated by Google

Introduction to Computer Aided Design (CAD) EPFL

6. BASIC EXERCISE 3: 3D GEAR WHEEL

3 ROUE DENTEE
— = Plan xy
— .~ Plan yz
— .~ Plan zx
=% Corps principal
— @ 34CrNiMo6
#@ Extrusion.1
5 Esquisse.1
ﬁ-@ Extrusion.2
,, < Esquisse.2
=-{p] Trou.1
[ Esquisse.3
= 0) Trou.2
m Esquisse .4
— 4% Répétition circulaire.1
r@ Poche.1
s Esquisse.5
- ¢ Répétition circulaire.2
i‘% Esquisse .6
I—ﬁ “Matériau” =34 Cr Ni Mo 6
—% Set géométrique.1

FINAL RESULT

Construction process : > Creation of spans & holes
> Creation of the teeth
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Select = click once with the left mouse button b

Start menu > Part Design > enter the name of the part: GEAR WHEEL > OK
File menu > Save > L: Catia > file name: GEAR WHEEL > Save

SPAN @ 75.55 mm

© o @
" the ZX plane in the tree structure > SKETCH

e

¥ CIRCLE > place the center on the origin = approach the origin with the cursor
until the symbol appears (coincidence betweerftwo points),
- -
~ to setthe center > circle
of any diameter.

anywhere in the window to put the

| BN

AL
~ Bl CONSTRAINTS > set dimension > 2x “~" on the diameter value > enter 75.55 > OK

m
s I'I.'I LEAVING THE WORKSHOP

o

@' EXTRUSION > Type: Length > enter 16 > OK

Premuse ke

Troe: ilh:w--

Longues © | b
|

Profilf St sce

Stiection - [[squmse |

L Epaser

il Tid ia 14 BT

[ st ermon vymst-ge

verpen by dretion |

P> |

9 ox | 9 meeie | |
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SPAN J 43 mm

KL
“~ the face of the @ 75.55 span as the sketch plane

ROUE DENTEE
@ @l SKETCH ‘ﬁj
e Plan Xy Définition de I'extrusion
L Plan ‘J’Z Premiére limite
-:D = “ Type: Longueur v;
b ®v CIRCLE > E; the center on the origin > —< Plan 2x el [ T —
. -‘v-{?} Corps principal RS o oo stioction
-~ anywhere in the window to place the circle of an - ; ~ Profi{Surface
diameter. ’ ’ T Extrusion-1 Séecin [ s )
: =- " Esquisse.1 O epaissi
!:D ﬁL . . E:D [] Extension symétrique
- CONSTRAINTS > set the dimension > 2x Inverser la direction_|
on the diameter value > enter 43 > OK
Plus >> |
@ Ok @ annuler | apercu |
' |1"”|, Esquisse.2 :I

@ li'l LEAVING THE WORKSHOP —@Setgéométriquej
Sketch plane

L @'
N~ EXTRUSION > Type: Length > enter 3 > OK
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& /ROUE DENTEE
HOE Q 39 mm — .~ Plan xy Définition du trou E]@
—.— Plan YZ As Extension I Type | Définition du taraudage |

!:D —.— Plan zx T .iJusqu'au suivant L]

~ @ HOLE =~ Corps principal Diemetrs : [33mm =) _41‘.3—_1,_]

N

E:D i b i Edition de ['esquisse

- face of the @43 staff (the hole appears in red) = @l

61[3 Géomeétrie Direction Fond
X E]Conh’aintes Inverser | [Limiee =l
“~" Extension tab : Up to next > Diameter : 39 mm > »- l-lPerDendculalrealasurface bode [T
OK Esquisse.2
= @ ok | Ssonder| oo |

—20 Set géométrique.1

Note : By default, Catia places the hole in the center of the chosen surface; if this is not the desired location, you must dimension the

center of the hole by going to Edit the sketcg’ﬂ

AHOIES AA43 mm BIADES @83 mm prof 45mm

B8
- &) HoLE

| B
~~ the face of the @ 75.55 span (opposite the @43
span)

Several topological error messages > OK (the
hole is empty: no material to remove)

©

-~/ Extension tab : Up to next > Diameter : 4.3 mm

3 ROUE DENTEE
— .= Plan xy
—.—Plan yz
—.— Plan zx
I—@ Corps principal

5

ri‘, Esquisse.3
] .
“Matériau” =Aucun
—@ Set géométrique.1

|Jusqu‘au suivant LJ
Diamétre : | 4,3mm E _&I
- B

T

' ~ Edition de 'esquisse
Offset : Omm E m
Direction Fond

Inverser I ,ﬁ

I3 perpendiculaire & la surface E
I

i Qo] i |
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}? ROUE DENTEE Définition du trou [[E3
~~ Type tab : Blade > Diameter: 8 mm > Depth : 4.5 mm . S [T Ditioniwrsos |
=~ Plan zx fams =
""E';@COTDS principal Paramétres . ﬂ‘
Diaétrs:  [m B & !
E:I:} A m g, o ;;-_;:ic__)EquISSE.l - H
~* Extension tab > Nt Editing the sketch T@Extrusionz
{74 Esquisse.2 e
=~ Trou.l :mr:ménd'@wlieu
@Eswisses \
*~ (and hold down) on the center of the hole and move it to Kggl L '
ape . . . rlau =Aucun 3 & Annuler
facilitate dimensioning P - 2] ot

N/

on the dimension value > enter 27.5 > OK

K anf
[ pistance [ Fixe
L. 1 3 Coincidence
27,5 O O
O m}
{ O o |
O Oe
O O
O O
O
- @ oK I & Annuler |

L | i
o EL CONSTRAINTS > -~ the horizontal axis Hand " on the point > set the dimension > 2x
. o . |
“~ on the vertical axis V > hold down the Ctrl key and Ctrl *~" on the point (two selected elements turn red) > drop the
key
| BN
\/ %I SELECTED CONSTRAINTS IN A DIALOG BOX
|
*.~ Coincidence > OK
&3 ROUE DENTEE
— .= Plan xy
—_.— Plan yz
— = Plan zx
-:D |r§@ Corps pril:lcipal
7 £ LEAVING THE WORKSHOP T‘?E;‘“US'O"J
':[:] 73 Esquisse.1
7 okay F- 75 Esquisse.2
Troul
l_—/ﬁEsquisse.Zi
&) Trou.2
=y
B "Matériau” =Aucun

‘-% Set géométrique.1
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CIRCULAR REPEAT

K1
> 2x Escape/Esc to no longer have a selection (no more items in red) (or “~ next to the object)

| BN
“~ Hole.2 in tree view (hole turns red)

KL
~ {}‘ CIRCULAR REPEAT (behind i RECTANGULAR REPEAT)

" Axial reference tab
> Parameters: whole crown

> Instances: 4

|_BE
> ./ Reference element : - face of the @ 75.55 span (opposite to the @43 span)
> Enable Keep Specifications
>0K
@ROUE DENTEE Définition de la répétition circulaire
=gy
_Zm:: :Z Référence axiale | Définition d'une couronne
— .~ Plan zx Paramdires: | Couronne entiére |
r—@Corps principal :m""s;t - :4 ?j
t - spacement angulaire : = =
r? Angle total ; | E@

Direction de référence
b Elément de référence: [Extrusion. 1\Face.:
Inversion de la direction

Elément & copier

ﬁ-[’ﬂ Esquisse.3

Obi_st d'ancrage:| Trou.2
@rﬂ Esquisse .4 _Plus>> |
é:’ z ,” 2 ire.1 ,m & Annuler I Apercu ]

g “Matériau” =Aucun
—@ Set géométrique.1
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CREATION OF THE TS TYPE TEETH WITH 48 TEETH

(Toothed belt Z48T5)

Calculations: Diameters:
* *

Pitch diameter of the belt: d = pb 48 / 3.14 /Y6894

Outside diameter of the crown: d0 =d - 2u = 76.394 — 2* 0.42 y 75.554

Inside diameter of the crown: di=d0 - 2 ht = 75.554 — 2*1.2 y 73.154

Pitch: pb =5 mm
Number of teeth: z = 48

Tooth height: ht = 1.2 mm

Distance between 2 teeth (top of the tooth): s = 2.65 mm

Angle between 2 teeth: 2y = 40° Radii int. and ext. of the Angles:
teeth: rb = rt = 0.4 mm Distance from the top of the tooth .
to the pitch diameter of the belt: u = 0.42 Pitch angle: (360° / (Y d)) * 5=7.5°0or 360° / 48 = 7.5° (= 2*3.75°)

Angle between 2 teeth (top of the tooth): (360°/(y  d)) * 265393.975° (y

Preliminary remarks : - The bottom of the tooth is an arc of a circle of @
73.15mm - The top of the tooth is an arc of a circle of @
75.55mm - The lines that are not used for the pocket must be construction lines (lines dotted)
- The curve that delimits the pocket does not necessarily have to be closed, but its ends must

be outside the part.

Teeth:
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n o @
Creation of the sketch : ~ the ZX plane in the tree structure > SKETCH

BUILDING FEATURES:

| BN

OE -,
~ < RIGHT > ~" the origin = approach the origin with the cursor
until the symbol appears (coincidenc®between two points)
KD
> 7 outside the room (top right) > Construct 3 straight lines in this way
o oo
" leftmost right > "™ CONSTRAINTS chosen in a dialog box >
S & o o
e CONSTRAINTS > rightmost right and " middle right > set dimension
-
> 2x angle value > enter 1.99° > OK
O B - -
CONSTRAINTS > rightmost right and " vertical line > set the dimension
<
> 2x angle value > enter 3.75° > OK

-
2x a-ine > activate Construction element > OK

> Do the same with the other 2 straight lines (the lines become dotted)

>Hold down the Ctrl key and select the two non-vertical lines

&L dib ©
= 7'%1 MIRROR > ™ axis of symmetry (= the vertical line)

Note : During the symmetry operation, the
previously established constraints will be taken

into account. ‘
|

N\,

Verticality > OK

JdN

Edition de la droite k43
Extrémié | Extrémité 2
Cartésiennes I Polyres I Cartégimnnes I Polares |
wed B x: B B
vi | B v: [s9smm B
Paramdtros
Longuewr ;| 55,095mm Bl ange: [86.250e =
< Elément de construction
@ ok | @ anewier |
b
= = 75°©
1%
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CONSTRUCTION OF A HALF TOOTH (without roundings):

Tip : Don't hesitate to zoom in / zoom out to set the points.

@ C.v ARC OF CIRCLE > @ on the Origin > e right of

construction (2) and@rtical line (cf. image on the right) (the symbol ©
must appear to indicate the coincidence)

© Y CONSTRAINTS > set dimension > > Ratlius object >

Definition > Dimension : choose diameter > Diameter: enter 75.55
> 0K

© /. RIGHT > © left end of the arc > © bottom left as shown in the figure above.

© al CONSTRAINTS > © on the previous right and O on the leftmost construction line > set the dimension >

2X grj/jthe angle value > enter 20° > OK i
|

droite (1)
E/D (‘, ARC OF CIRCLE > e on the origin > 6 left end of

f———t -

the last straight line built and

E/D construction line (1)

EI/J al CONSTRAINTS > set the dimension > put a diameter of 73.15 as
before > OK
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* *
Sz 3 e —
/. RIGHT > end of the last arc built (373.15) . | | |
1
9 PR . Il : ] —-——3,75°
and on the construction line (1), outside the room 1‘ 1I :
| |
!-:9 next to the object to remove all selections | :
|

CONSTRUCTION OF ROUNDS:

Create the two roundings of radius 0.4 (see figure) as follows:

v, " ROUND >

EJ/:] the two straight lines between which we want

the rounding > place the rounding g-:;x on the dimension > enter a radius of
0.4 > OK

August 2010
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CONSTRUCTION OF THE OTHER HALF TOOTH: o

partie a

Proceed by symmetry to build the other side: reproduire

> Select the part to reproduce while holding down the Ctrl key (6 elements)

@ gl«hfl MIRROR > 8

the vertical construction line (the middle line)

Then close the sketch:

‘l" - . - - -
@ 0% ARC OF CIRCLE > 9 on the origin > @ on the extreme lines to close the contour (see image on the right)

Note- The last arc made is white, which means the sketch is not fully constrained. It is therefore necessary to apply any diameter to this arc, so that it is
greater than the diameter of the wheel.

@ FTH LEAVING THE WORKSHOP
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© POACHED

> Type : Up to next (reverse direction and side if
necessary)

Preview, if the result is satisfactory (figure
beside) > OK

CIRCULAR REPEAT :

©

Pocket.1 in tree view (pocket turns red)

=
e {} Irmtances - ’“ m
» CIRCULAR REPEAT BRI
EI/] secge et [ =5
Axial reference tab iyl
> Parameters: Whole Crown oA
> Instances : enter 48 [o—p—
@ cmunlbum—_.J
> Reference direction: @ the face of the staff oo et —]
75.55 > Disable: Keep . @ o | Swns | [

specifications

>0K
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MATERIAL APPLICATION

e APPLY MATERIALS

L8 .
" Ac improvement tab > ~~ 34Cr Ni Mo 6

* in the Main Body tree

(The outline of the part turns red)

E:D
< Apply Material
>0K

File > Save

i

gk

HONME
Extruson. 1
&\ Esqueses. |

Trow.2

2\ Esqusse 5
Répétiton craare. |
Poche. 1

A\ Esqusse?

‘Maténiau”’ =34 Or NMo 6

—
B isome Bt (e e e UN e e

S o cenes
7P vy
&7 Pun v
£ Pl Ex

- ) cos pmepa

o MOk

»Tm—mn;
2 Bagune |

P{fl‘hul

Esquene )

L

r

b-?m..: ‘)
[SST L) 5

LY

(

¢

= Répemoon crouere 1
P-EI\-JH 1
£tingume 7

[REESITINIST

O
-' Mating) = O HMOE

=J)e a2
{IE T P
7 Eauiee 2 ¢

/f" Py ——————

Cizls)
e el e el Bl B el e L |
-l
QM AV <o p 10 QOoMAY» ¢ XX s
WMoY 4 BT L 6 Cr Mo V)
o €76 %0 SA0
|
) = e

August 2010

-71 -



Machine Translated by Google

Introduction to Computer Aided Design (CAD)

EPFL

7. EXAMPLES OF TEST 1

| 2 | 3 | 4 6 | 7 8
255
125 75 =02
Al «
e
Fh -
T 7€ © | "
S ’ I— e - | 8
’ |
' 1 (4%
Traversa
B
i@ | po
\ @ '
-
' 11|
I
160
225
A-A
. D11 (4x) @74 HY TTo Ta]
t ;
| /L// / I T_@, o
o~
Ra32 / ~ =
o P65 (4] - 2
160 & o
25 = 2
/ Ra63 #—
( )
Chanfrein 0,2x45° Carms 16.00.2010 Jenrilfer Gesparcus 1—1
Tolérances générales : = -
NF EN 22768 -m =
(IS0 2768 -m) EH&
as R= 34 CrNiMa 6 — T = —
Rayons non cotés R=0,5 — A3 I 1 1
Nickelage chimigue SUPPORT o
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1 l | 3 4 5 | 6 | g | 8
255
205 AA
1
15 DT4AHT
[A] 85 1Joo1 [a
o 80 ‘g
e @6.,6(6x) &
Ra 32
- s R A | S
g : AT G |
@11(6x) 7 o
{ 225 . 25
115 =02 %
15 50 202
w0 L
& =
a2 (1 —=m|=4 .
(=]
=T
-
o] __'féf’"/a 1 @66  Traversant (x4)
e _____@),______g,z)_____
\\
=S| o« A &
8l 8 | .
8| 8 A
uw
i£: -
\@ @ @
.
b | = ( ]
- - Cvem 21,04,2008 Jenrafer Ganparous s
2 Chanrein 0,2x45° — "
Tolérances générales : o
vaversant /ol 100, % NF EN 22768-m e o S _ SC
_ * e Mmiriaunondadn  ows | | =ee W o 2
- (IS0 2768 - m) === TN , AE' 1 1
Nickelage chimique :‘. )f z SUPPORT 2
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8. BASIC EXERCISE 4: 2D GEAR WHEEL

1 | 2 | 3 | 4
A |
=] -
4.5 <k =
-
Q)
-] —"’71 =
B
H
|
| Bl
Bl 3 2ol =3l 23
¢ ol 2T [ 2| o 2[R
| g al & ¢
B
- =
o4 :
o R Max 0.4
Rt
/i
3
19
Caractéristiques : Tolérances générales :
Type T5 NF EN 22768 - m %/
nbdedents 2=48  (ISO 2768 - m)
- -_«.- e e aosoaroa o
g e Ad 1]
ROUE DENTEE

FINAL RESULT
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File menu > New > Drawing > OK > Standard: DETAIL ISO > Sheet style: A4 ISO > Orientation: Portrait > OK

File menu > Save > L : Catia > file name: GEAR WHEEL > Save

@ Layer (in tree) > Properties > Scale: 2:1 > OK

| B8
File menu > Open > " GEAR WHEEL.CATPart > Open

Window menu > Horizontal Tile

| a8
" in the Drawing window (GEAR.CATDrawing)
| @
*=, FRONT VIEW
| a8

" ZX plane of the 3D window (GEAR WHEEL.CATPart): The selected view is displayed in 2D.

Using the tool

|
“~ (Hold) the frame and move the piece to the left of the A4 sheet

| a8
“~ next to the view to confirm the position.

(3| CATIA V5 pour étudiant - [DRAWINGT ]

B) ot e Edtion  gffchage  [eerten  (uts

w| | [Merospacezt - |

DRAWING1 2] I caan.1 |

Carirer lo graphe
Becadrer ar

& Couper Cubex

Ry Copler QrieC

nc@v Qv
Cofagn speod

o Doonitis _____ Meeree |

B, Ersembies de stietions. e

(= Egtion det ersermbles de séanctaons.
Chget Calgue. | L

(2] Cache jadficher F2
Activer e calgue

I

i I -, rotate the front view so as to obtain the same view as that of the figure opposite
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U0
g CARTRIDGE CREATION

The A4 cartridge appears on the screen.

The name of the GEAR WHEEL drawing appears in the title block. To modify the cartridge, W
proceed as explained on page 36. A
ol iz (8 e

e BROKEN CUT > " on the vertical axis of the part (above the
piece)

[ 88 x)
> 2x on'the vertical axis of the room (below the room > plan (A4 sheet) ~ — in the center of B B
to place the cut.
P Analyse
i > & o
" View > Toolbars > Analyze > /'—

>Show geometry in all viewpoints Afficher la géométrie
dans tous les points de vue

a1

r

on the different views (front view and section)
This tool allows you to visualize the position of the 3D part for each view of the drawing.

&[5 8, O R

~ 1 71 |ISOMETRIC VIEW (behind FRONT VIEW) > " on"WHEEL L ‘ =TT 24
DENTEE" (in the tree structure of the 3D window) > choose the view where you can see the most Bo— =)
details (see figure) o O —— Adal 1] 1

-, _!(Pﬂj ''''' ROUE DENTEE o
Position the view somewhere outside the A4 sheet > ~ next to confirm
[an ) \

the position > 2x on'this view > on the frame of this view > Properties > Scale: 1:1 > OK

Reposition the view on the A4 sheet, at the bottom left of the section. :
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Checking links 4.5 = = e
>
So o 5
- File menu > " Office > check that the two documents are side by side / ol
=t
B §# ©ROUE DENTEE.CATDrawi g JROUE DENTEE.CATPart] i / // =
close office '/_ ==
T/
DIMENSION OF THE BROKEN CUT For =il
more visibility now, you can shrink the 3D window and enlarge the Drawing window. fSOL
[ 88
Activate view frame (2x ~ on the frame, the latter turns red) -
Ly o) o3
54 IS i I Y
[
LS

[ SaR
./ =% QUOTATIONS

Create dimensions 4.5; 19; 3

KD o
./ = DIAMETER QUOTATIONS

Create @ 8; @ 4.3; @55; @39; B43; @ 75.55

D43
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@ on the @ 8 > Properties > Dimension texts tab > to the right of Main value enter (4x) > OK
Do the same with @ 4.3 4.5
- ]
Propriétés —
Propriées Y 2
Sélection : | G‘r
Tolérance l Ligne de cote | Ligne de rappel Textes de la cote | Police S R — L
Préfixe - Suffixe ! /
ﬁvl yaleur principale | | e i
[+
Textes Associés (S
|
| valeur principale | (4x) o ~ 9 o
[ w0 b So| o3
el BT T T | =
S IS YIRS
@ on @ 55 > Properties > Tolerance tab > Main Value: select
104 ¢ TOL_NUM2 >
Upper value : enter +0.2 >
Lower value : enter - 0.2 > OK Y
Do the same with @ 39; @ 43 (see the image on the right for the N i
corresponding tolerances)
\
3

19

-78 -
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.
“aw

Create a horizontal line above the wheel (the line must be longer than the thickness of the wheel)
If necessary, it is possible to deactivate the snapping of the points, which allows greater flexibility for setting the line; to

this, click on the icon % . Droite 1
Droite 2

Y on the right > Properties > Chart tab ' : <+
> Line: 4 > Thickness: 2 > OK i Wy o ]
-t

KD ' _Y
" 2x on the right (Editing the right) i
>End 1>V: 38.175 > End 2 | I .

> V: 38.175 > OK (leave
default values for H)

78(4x)

"
 Law

Create a horizontal line above the wheel (the line must be longer than the thickness of the wheel)

@ On the right > Properties > Chart tab 21x|

> Line: 4 > Thickness: 2 > OK SERTHEDE R
—Extrémiteé 1 Extrémite 2

Cartésiennes | Polaires I Cartésiennes | Polaires l

|_BN
~ 2x on the right (Editing the right) H: |omm ksl
>End1>V:36.575>End 2 v: [36.575mm v: [36575mm

>V: 36.575 > OK (leave . i
default values for H [t
) |Longueur : | 19mm Angle: |Odeg

H: |19mm

kbl (]

[] Elément de construction

@ ok | @ annuler |

-79 -
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. ki
Select the two lines ( el rlght 1 > hold the Ctrl key c\:;,.
- 45 -
pressed > -~ theright 2) » Q
h
1 17 [
RZZ7Z! '
KL iy ] _ | l Iy
S * MIRROR > " horizontal axis Jl_ 1 :
T
1 : I AI/ A
= I / |
z < I ] 1
] 2 - Lo = | l [
-/ **, DIAMETER QUOTATIONS > “ right1> ~ its symmetry TGSOa I : H
I | I
|
|
w ™ = : :: 2 S| w “©
0 = L SO mi el 5| L5=| =9 ==
7 » DIAMETER QUOTATIONS > -/ the rlght 2> ~ its Symmetry E g T _-— ‘_I: - —- T —g 2 S E
B I T |l Bl e
. | u ! =
@76.35 dimension > Properties > Dimension text tab l : E =
> to the left of Main Value enter (dprimitive > to the right of Main | | I =
Value enter ) > OK : : | ’ i
| / |
V7 f
I A \
0 v |
To hide the h symbols above the created lines, ~ on each of | ||
-, i
symbols and ~~ space bar. ll .
i
3
19
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] x:
'I V", ROUGHNESS SYMBOL

|_BN
" Inner surface (@39) of the gear wheel > enter N6 above the symbol >

Choose the Roughness symbol corresponding to the figure opposite > Ok > position the
symbol

Symbole de rugosité )

2x]
= 1 = Q\

fv/

Rotd:lr E p j ) Annulerl

To change the orientation of the symbol.

In the same way, place the Roughness symbol N7 as shown in the figure opposite.
Note : for more details on the standardization of these symbols, see the Fanchon
(pages 116-117)
) &5
" ¥ ATTACHED TEXT (behind TEXT)

" the corner of the @43 span > enter R Max 0.4 > OK (position the anchor as
needed)

D75.55

o )
<]E i
4,5 - .
=t
<
4 i
r
1 )
— /-
>
=
oY
i
~ '3 = To] ::?
E So|l ed| |2
I ol e 2R
< Ql & U=
=
a
N6 =
BV Y .
A I A _\
R Max 0,4
/// '
g

| 4
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EPFL

1]
* Bl rererence
| 88
" the inner surface (839) of the toothed wheel > set the reference >
enter A > OK

LR
7~ GEOMETRIC TOLERANCE (behind REFERENCE)
I

" the straight su&aflze of the toothed wheel (&875.55) > Select the symbol

single beat Z~ >Tolerance: 0.03 > Reference: A > OK
(Position the anchor if necessary)

Note: for more information on geometric tolerances: Fanchon (chapter 10)

<
<E 3
4.5 “
110 Q
) ~7/7¢
4
SR S —
A A
4| &
=
o |
@
2l 3 =] o2 =
o | ——— _Le =l | ©
SR 2l &l 8ls
=
=
NG i
77 S N
///
o e e R Max 0,4
L A
3
19
] \
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O 5 -,

N

N * the text as needatipve the title block > in Text editor write: Characteristics:...(see the image below) > TEXT > OK (position

* TEXT> 7 apove the cartridge > in Text editor write: General tolerances:...(see the image below

below) > OK (position the text as needed)

x=

bt * ROUGHNESS SYMBOL
m
~ above the title block > enter N9 above the symbol > Choose the Roughness symbol corresponding to the figure below
below > OK (position the symbol if necessary)

Caractéristiques : Tolérances générales :

Type TS NF EN 22768 -m NG

nb de dents 7=48  {I1SO 2768 - m)

Dessne 06,07,2009 jennifer gasparoux Echelo
- — 2:1
Sams nomenciatre separes = N \.;c ;:; n'.:'u;\:o — —— a@
Nomorclatue s @o mima N’ O Matiaro 34CrNiMo 6 Orgine Fon ” Feule W'
Nomencisture sép de N° o 1 | Wivss 0.393 kg Preriinon A4 1 1
PR ROUE DENTEE

File menu > Save
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e
4 v—
i

2:1

(6€'9.¢ ywnd p )
-« SL'ELD

g

e -l £3 :
[ 20°0- = % [ . ) i
P)E v o EVD = 8 ]
@ E i
0 ST |z 1)
— IN 90‘04-168@ (ﬂ' %g g E E(f
4 | | AN
i | | EENNE N 303
H\l\ = |\| o) D—Z:g
o |\\ i | ' N : e 5 Lu
BN S NI IR 1T
I\1 | N\ r z N . E
Uk i T B £ k1
- - S8 A
— 2 . zo:gg@ o ‘g';% ] e8] O
(7180 §Se || w
g|g
§6'6LQD 3k 8
gn
o~
§
: £
i HEHE
: 1
. d
==
— HEHE
1 “_
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9. BASIC EXERCISE 5: 3D ROLLING BLOCK

FINAL RESULT
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Start Menu > Part Design > enter part name: BEARING BLOCK > OK
File menu > Save > L: catia > file name: BLOCK BEARING > Save

REALIZATION OF THE BLOCK 82 x 82 x 70

(o8 [ un
< & SKETCH

~ the ZX plane in the tree structure >

-Zl |:] | N BN

¥ RECTANGULAR > - forthe 1stcorner ~ for the 2nd corner.

= g KD

-t CONSTRAINTS > “~" on each of the vertical sides of the rectangle > set the dimension > 2x
> okay

| BN ﬁL L.

CONSTRAINTS > "= on each of the horizontal sides of the rectangle > set the dimension > 2x
> okay

| BN |_BN|

=" on one of the vertical sides of the rectangle > keep the Ctrl key pressed: (the three selected

elements turn red) > release the Ctrl key

Note: Select items in the order listed! Otherwise the block will not be centered

on the origin.

[
-— % SELECTED CONSTRAINTS IN A BOX OF
DIALOGUE
Ko BN
" Symmetry and verticality > oK

23 BLOC ROULEMENT

.= Plan xy
— .~ Plan yz
.= Plan zx
l"é;@ Corps principal

I:% Repére
Géométrie

ﬁI Contraintes

—@ Set géométrique.1

Lomm. e

" on the odds value, enter 82

H &

-~ the other vertical side and

“ on the odds value, enter 82

" the vertical axis V

Contraintes @
[m] [ Fixe
[ Longueur O
[m] [m]
[m] m]
] [ paraliélisme
[m] a
4 Symétrie O
O 4 Verticalité
]
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FD . . fomned pofuvdendandiadundiaudaaleniunbas RN S SO Y SO o O T I s
-’ on one of the horizontal sides of the rectangle > y L i ? . B Contraintes BE|
. | D oistar CFi
keep the Ctrl key pressed: ™ the other sice =
. = |0 &ng Oco
horizontal gnd tghorizontal axis H (the three Ore e D7ent
selected elements turn red) > release the Citrl g f] e
key IR L
a 4 Horizontalité
. |Owie Ove
Note: Select items in the order listed! Otherwise the - B
block will not be centered on the origin 2 annuer |

!_]3 %I SELECTED CONSTRAINTS IN A DIALOG BOX

B8
" Symmetry and horizontality > OK Q’j] BLOC ROULEMENT Définition de rextrusion  [2][X]
— .~ Plan XY . Premiére limite i
Type : Longueur »
Y LEAVING THE WORKSHOP [~ Flan yz e =l
—.~ Plan zx A [Pas de sélection
ProfilfSurface
#—{3 Corps principal Sélection : [Esquisse. 1 |
- [ Epaissir
7 Bxtusion.1 ——
'.'@ Esquisse. 1 [C] Extension symétrique
!:D a Repére az Inverser la direction l
~/ EXTRUSION > Type : Length > enter 70 &L, Géométrie —
(reverse direction if necessary) > selection: last ) Qo] @umus] D]
sketch created #-[7{] Contraintes i —
!IJ —@ Set geométrique.1 B Y
- okay ‘
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THROUGH HOLE @ 43 BLADE @ 47 prof. 66mm

*} @ HoLE
T

appears

Extension tab : Up to next >
Diameter : 43mm

Edition de l'esquisse

o
9 m CONSTRAINTS >

vertical edge > set dimension > 2x
41 > okay

9 m CONSTRAINTS > e

horizontal > set dimension > 2x
> okay

T
!:9 = |LEAVING THE WORKSHOP (we find the definition of the hole)

a square face of the block (the hole appears
in red) and the Hole Definition window

hole center (white dot) > a

hole center > E a stop

éfinition du trou

E lBLO_(: ROULENE\JT ]Jusqu ‘au suivant __J

Diametre ; | 43mm E |
Profandeur |D'” E.

Limite Pas de sélection

Extension | Type I Definition du taraudage |

Edition de l'esquisse ———————

'~ Direction -

4 Perpendiculaire & la surface

|:.‘:,: de sélection

O E( @I
-~ Fond

andee {[Todeg

1
|L|ﬁ.\t»:- Jl

BLOC ROU_EMENT '

on the odds value, enter

©

on the odds value, enter 41

Type tab : Laminate > Diameter : 47 mm > Depth : 66 mm > OK > OK

|
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4 BLANK HOLES TAPPED M4 x 10/15

= aENEE e NNET
e T r——— ]

£3BLOC ROULEMENT
[~ Plan xy ~ Extension | Type | Défintion duteraudage |
!-:I/] ] = .2 Plan yz B S [ S
the face of the block opposite to the one [Tt Plan 2 venave: [ B
. . lF@Corps principal [I R § : -
chosen previously (the hole appearsinred) | Ecieommm |

@ @&

Type tab : Simple

@

Thread definition tab
enable: Tapped >

Type : Metric Coarse Pitch >
Ref. thread : M4 >

Teacher. thread : 10 mm >

Teacher. hole : 15mm >

activate: No right > OK

Extension tab : Blind > Bottom: V -shaped

T (A Esquisse. 1 e

=)
i—gﬂ Esquisse.5 -
5 set géométrique. 1

: gTrou.l i
[ Esquisse.2 R s

Profondeur : | 15mm E

- Edition de l'esquisse
.

@)
Direction Fond

Inverser | | [prat =

I3 Perpendiculaire 4 la surface |k I"—E

@ ok | @ annder |

aperu_|

Définition du trou

Extension | Type Deéfinition du taraudage |

IJ Taraudé

[~ Définition du taraudage -
|
Type: |Métrique Pas Gros il

RéF, taraudage: |M4

D. avant trou: [

@ Pas droit O pas gauche

t

Prof. taraudage: | 10mm @ 118 |
Prof. trou: | 15mm = Retrait |
Pas: |0, @

[~ Standards
i :

‘_ 9 | @ amnuer | apercu |

1L
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E—]/] Extension tab > EI/] @ Editing the sketch

e on the center point of the hole, keep it pressed and move it from the origin of the axes

e beside the view

© &_ PROJECTION OF 3D ELEMENTS

Rotate (page 10) the view so that you can see the inside of the bore made previously

!-j/] cylindrical face of the through hole @ 43 > a white line appears, it represents the axis of the

selected surface.

Note: The Project 3D Elements operation projects 3D elements into the sketch.

Here, this operation made it possible to project the axis of the cylinder on the plane of the sketch. A point is thus obtained which appears in red.

e

AxefTrou.1/Corps principal

Face to select

August 2010
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.?
To return to the sketch plane : : NORMAL VIEW located at the bottom of the screen.

EI/] /'l RIGHT > draw a line between the red point (projected previously)
and the center of the hole (white point)

LULERCIERTTEL B IOt

!:I-/] beside the view

Note : the straight line automatically becomes Construction element (straight in
dotted)
9 ﬁ CONSTRAINTS > 9 line previous|y created > e horizontal axis >

set dimension > 2x e on the dimension value > enter 45° > OK

8 E‘* CONSTRAINTS > 9 straight line previously created > set the dimension >

ZXE/D

on the dimension value > enter 27.5 > OK

Ty
@ = LEAVING THE WORKSHOP (we find ourselves in the definition of the hole)

O

okay
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Circular repeat

O Hole.2 (= last hole created) in the tree structure (the hole turns red) Cylindrical face to select

E:B Qv CIRCULAR REPEAT

BLOC ROULEMENT Définition de ia répétition circulaire
L7 Plan xy
7 Planyz cfdrence axiale | Définition d'une{couronne
aramétres |Couronne enfiere L”
Z7 Plan zx .
| [Instances : [4 ‘
==22 Corps principal : ‘
ps princp [Espacement angulaire : I i0deq = :
=-(f ) Exirusion. 1 ; =
?? {Angle total : | 360dec E‘h ‘
B 5% i L |
.2, Esquisse. 1 ‘ Direction de référence "
- - |Elément de référence:| Trou. 11Face.2
g
-7 Esquisse.2 | Inversion de la direction |
. - Composant & copier
. ;M;f; Esquisse.4 Composant : |Trou.2 EJ
[ QE : 'll ircylaire, I iConserver les spécifications
Plus>> |
@ ok | Sannuer | apercu |

>,

Axial reference tab > Parameters: Entire crown > Instances : enter 4 > Reference element : ~ the cylindrical face
(243) of the block > activate: Keep specifications

s okay
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4 BLANK TAPPED HOLES M6 x 10/15

KD
— € HoLE

BN
" the face of the block opposite the 4 previous
holes (the hole appears in red)

Extension tab : Blind > Bottom: V -shaped

ype tab : Simple

BRA @

o

\

T
Thread definition tab
enable: Tapped >

Type : Metric Coarse Pitch >
Ref. thread : M6 >
Teacher. thread : 10 mm>

Teacher. hole : 15mm >

enable: Not right

©

# "
Extension tab > @ E’ Editing the sketch

&3BLOC ROULEMENT
= _~>Plan xy
22 Plan yz
,,,,, > Plan zx
'P@ Corps principal
Extruson..
@ 2 Esqusse 1
Trou 1
I_ﬂ Esquisse.2
Trou. 2
.'@ Esquisse.5
4} Répétition circLlare. 1

E& Esquisse.?

—@ Set géométrique. 1

Définition du trou

Extension | Type |

|
Diamétre : d E@ |
Profondeur : | 15mm E

=
Direction

Inverser I

& Perpendiculaire & la surface

[

Type I Définition du taraudage l

Edition de l'esquisse
24
Fond

@ ok | @ annuer |

apersu_|

?IX]

4 Taraudé
Définition du taraudage
Type: lMétr%que Pas Gros Ll
RéF, taraudage: |M6 ~|
D. avant trou: | .@ Standards
PR .T S—
Prof, taraudage: | 10mm B3]
Prof. trou: | 15mm = Retrait |
Pas: | @
@ pasdrot O Pas gauche
@ ok | @annder| apercu |
.
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L
0

on the center point of the hole, keep it pressed and move it from the origin of the axes (without this operation, the following dimension is not valid, it is seen
as overstressed)

D =
' &5, PROJECTION OF 3D ELEMENTS
Rotate (page 10) the view so that you can see the inside of the bore made previously

n
~ cylindrical face of the through hole @ 43 > a white line appears, it represents the axis of the selected surface.
=
To return to the sketch plane : NORMAL VIEW located at the bottom of the screen.
F -
¥ RIGHT > draw a line between the red point (projected previously) and the center of the hole (white point)
| BN
' beside the view
BN ﬁL K L L _ _
CONSTRAINTS > = previously created line " horizontal axis > set dimension >2x — on the dimension value > enter 45°
> okay
B E:L . |
CONSTRAINTS > St line previously created > set the dimension > 2x —" on the dimension value > enter 30 > OK
- :'J l'iJ
LEAVING THE WORKSHOP (we find ourselves in the definition of the hole)

“ okay

August 2010 -94 -



Machine Translated by Google

Introduction to Computer Aided Design (CAD) EPFL

Circular repeat

E]/] Cylindrical face to select
Hole.3 (= last hole created) in the tree structure (the hole turns red)

EI/] {}v CIRCULAR REPEAT

Définition de la répétition circulaire

Dwection de référence
| EMmant de référence:| Trou. 11Face 4
nversion de la drection |
Composant & copier
Composant : |Trou.3 !l
"":’Rmmcfme.l [J Conserver les spécfications
Trou.3 B> |
{\Esquisse.6 D ok | @ soeuer| _spmou |
£ Répétmon cradare 2 I

©

E} Axial reference tab > Parameters: Entire crown > Instances : enter 4 > Reference element :
(@47) of the block > activate: Keep specifications

©

the cylindrical face

okay
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4 THROUGH HOL_ES D 6.5 &3 BLOC ROULEMENT

— .= Plan xy
—.— Plan yz

@ @ HOLE .= Plan zx

=-:93 Corps principal

Définition du trou l? &|

:}i Type | Définition du taraudage |

fi .
a block face y to the previously chosen face. |23 Coqunse.l
[©] Trou.t
DYtrou2 % ' N =z
Thread definition tab : Deselect thread &% Répétition circulaire.1 - L E—— mm;rET ‘
Direction  Fond 1
_MI Limité =

Type tab : Simple

Extension tab : Up to next > Diameter : 6.5

el

—£2¥ Set géométrique 1

Editing the sketch

23)BLOC ROULEMENT
—.— Plan xy
—.— Plan yz
!:B ajv CONSTRAINTS > El/j horizontal edge of the face e about <7 Plan zx
=-93 Corps principal
> set the dimension > 2x on the dimension value > enter 10 > OK g?‘“”j"’"-i
rou.
Trou.2
8 BL CONSTRAINTS > !:9 vertical edge of the face e on point > — < Répétition circulaire.1
P A
@ rou.3
set dimension > 2x on the dimension value > enter 10 > OK — 42> Répétition circulaire.2
T.
@ B3 | EAVING THE WORKSHOP
9 —E2F Set géométrique.1

okay
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Rectangular repeat

!-]/] Hole.4 (=last hole created) in the tree structure (hole
turns red)

EI/] m-! RECTANGULAR REPEAT

@ tab: First direction >

Settings: Instances & Spacing >
Instances : enter 2 >

Spacing : enter 62 >

Reference direction : © Plan on which was placed
the hole > Reverse direction if necessary

activate: Keep specifications

@ Second direction tab >
Settings: Instances & Spacing >

Instances : enter 2 >
Spacing : enter 50 > Reverse direction if necessary

!-:I/] okay

& BLOC ROULEMENT
—
—.— Plan yz
—.— Plan zx

—@ Set géométrique.1

Répétition rectangulaire @

econde drection |

Parametres: [1nctances & espacement v |
Instances: |2 =
iEsmmemenl: H M
tonguew: [ @
~Direction de référence ———————————————

{Elément de néFérenre:W

i Inversion I

Objet & copier
{ Objet d'ancrage:[Troud

& conserver les spécifications

Plus»l
@ ok | @annuer| Apercu |

Répétition rectangulaire

ir
Premigre direction |}

Paramétres: IInstan

ces & espacement ‘j

Instances: |2

Espacement : | S0mm

Longueur : | S0mr

Inversion

Direction de référence

Elément de référence:|plan xy

| Obijet & copier

\Objet d'ancrage:|Trou.4 ‘

} ‘4 Conserver les spécifications |

bo oK |0Annu|ar| Apercu |

Plus:> I
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3 BLOC ROULEMENT
2 BLANK HOLES @ 6 > Plan xy
.= Plan yz
. Plan zx
F-i93 Corps principal
Y@ voe Tt
@Trou.l
Trou.2
e <% Répétition circulaire.1
the same face of the block as before (the hole Trou.3
appears in red) gRépétitlon circulaire .2
Trou.4
Reépétition rectangulaire.1
E/D Extension tab : Blind > Diameter : enter 6 > m- '
Depth : enter 12 > Bottom: In V Esqu,sse 12 — (8 ok | @amier] oo |
e f Esqmsse 4
Type tab : Simple L@ ot ot 1

!:B Ej/] ‘_@l #7BLOC ROULEMENT . a1 .

Editing the sketch ~_~ Plan xy
—.— Plan yz

Extension tab >

—~ Plan zx
© B consTRAINTS > © longest edge of the face o 1B icea
¢#) Extrusion. 1

the point > set the dimension > 2x on the odds value > enter 10 (6] Trou-t

> oka Trou.2
y -

<7» Répétition circulaire.1

Trou.3

. <7» Répétition circulaire.2
!:B & CONSTRAINTS > !:9 shortest edge of the face 8 on ) Trou

@ ) . 435 Répétition rectangulalre 1
the point > set the dimension > 2x on the value of the dimension > enter 41 :

> okay

72 Esquisse .4

@ ‘i.l LEAVING THE WORKSHOP —i2¥ Set géométrique.1

©

okay
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Rectangular repeat

E—j’]' Hole.5 in the tree

©

Settings: Instances & Spacing >
Instances : enter 2 >

Spacing : enter 50 >

Second direction tab >

Reference direction : O Plane on which the hole was
placed > Reverse the direction if necessary activate: Keep

specifications

©

First direction tab >

Settings: Instances & Spacing >
Instances : enter 1 >

<=

-/ okay

&3 1BLOC ROULEMENT

=-93 Corps principal

-7 Extrusion.1 |

; @ Trou.1

; Trou.2
<% Répétition circulaire.1
Trou.3 |
< Répétition circulaire.2|

@ Trou.4

—@ Set géométrique.1

Répétition rectangulaire

l Seconde direction |

Répétition rectangulaire @
Premigre direction F
Paramétres: lm
Instances : IZ—E
Espa:ament:lEi&ﬂm—E
Longueur ¢ I—E@

-Direction de référence
Elément de référen:e:iplan xy
Inversion '
Objet & copler
Objet d'ancrage:| Trou.5

I3 Conserver les spécifications

Plus>> I
‘ ﬂAml.larI Apercu I

Parametres: |[nstances & espacement v |

Direction de référence
Elément de référence:[man xy
Inversion |

Instances : ] 1 @
Espacement : iUmm @
Longueur: |

[ Objet & copier
Objet d'ancrage:| Trou.5

"4 Conserver les spécifications

Phs))l
@ OK l Cnnnuierl Apercu I
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BEVELS

Y & CHAMFER

Mode: Lengthl/Angle >
Length 1: enter 1 >

Angle : between 45 >

Objects to be chamfered:ﬁge facing the outer face of
the @ 43 hole.

E_:I/] okay

Repeat the operation for the edge facing the outer face
of the @ 47 hole.

Definition du chanfrein E|

Mode : | Longueur1fAngle LI
Longueurl : [ 1mm

angle : |45deg

Objets a chanfreiner:

Propagation ! ITangence El
[ Inverser

August 2010
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APPLICATION OF MATERIALS

©'a APPLICATION OF MATERIALS

© ©

Light alloys tab > EN-AC-AISi7Mg0.3T6

in the Main Body tree view (part outline turns red)

©
©

Apply Material

okay

File > Save

43 /BLOC ROULEMENT
. Plan xy
< Plan yz
. Plan zx

y

“Matériau” =EN AC-AISi7Mg0.3 T6
—EY set géométrique.1

BLOC ROULEMENT

L7 Plan xy

27 Plan yz

£7 Plan 2x

{8 corps principa

W ENAC-AIS7MgO.3 T6
Extrusion.1
:ﬂf\“Equ)sse. 1

=10 ) Trou. 1
{A\Esqusse.2
Trou.2
{Z\Esquisse.4

=4 Répétition circulaire. 1

[
Esquissess

{3 Répétition circudaire.2
=~[C) Trou 4
{ N Esquisse8
— 18§ népétition rectanguiaire, 1

8-|C ) Trou.s
(s Esquisse. 10

— 1 pépéttion rectangulaire 2

(G cranfiein. 1

—J canren.2

B Matériau =EN AC-AISI7MG0. 3 T6

Bibliothéque {Lecture seule)

|Catalogue de matériaux par défaut

Acoutis | | F

e

EN AC-AISI7Mg0.3 T6 EM AC-AlSioMg Te

EN AW-A|MgSi TE EM AW-A| SitMghin T&

I svreue |Mtérnox oyt o] |

n ‘

EN AW-AIMg EN AW-A Mg3

=

EN AW-AISIMg(A)TE BN AW-AISIIMgMN T
Mg G-A6Z1 RZ5TS

7

) O | _sppiquer matésiau_| Fermar |

August 2010
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10. BASIC EXERCISE #6: 2D ROLLING BLOCK

1 | 2 3 | 4 | 5 | 3 | 7 | 8
AN 70 £
, 56 =
T N ] =
=| | ‘ o =
\ \w\ & RN o —————— —
N, 4-/ \‘é\ 8 \ N
] |
T \ ' 12
__________ - - \ I B =
B i1 % | I\ < i
L&)
RMax 0.3 4 w0
— %/ | =1
SN ~
_— \ v o o - et o > — e —
\ N\ \ S N N \

Coupe A-A Caupe B-B

= O (‘f} s
v xi2
\ b
D pi :
& u A s wi & T
@ o :
= I
] IA : A
b I
e e
E
@sr B
@ 10 50 1i0s
Tolérances genérales - a@l
= 1
NF EN 22766 - o T A - —
F fISOZ?S&-MJm = l;‘" 1 A3] 101

Nickelage chimique

" BLOC ROULEMENT

FINAL RESULT
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File menu > New > Drawing > OK > Standard: DETAIL ISO > Shape Style: A3 ISO > Orientation: Landscape > OK
File menu > Save > L: catia > file name: BEARING BLOCK > OK

File menu > Open >
| 1'J
" BLOCK BEARING.CATPart > Open

5777%

Window menu > Horizontal Tile

|
|
|
|
:
\
Creation of the different views |
\
|
|
|
|
|
|
|

|_BN Ko ] 7
" in the Drawing window and | =% FRONT VIEW W
| :'J
“ the surface with the 6 holes. The selected view is displayed in 2D, using the tool Coupe A-A
I e = ] i
] ]

v

position the view as in the figure
(ATTENTION - 343 on the left and @47 on the right)
[ o

\

|

: |
~ beside the view eo—---6|- |
b [T

J

|

\

\

) dp
" BROKEN CUT > create the AA cut @ @

@the frame of the broken section AA > Object AA section > Add view name === == :
N
2X " on writing > Clear scale, just leave AA cut > OK Reposition text if needed.

Note : the scale of a view should not be entered if it is the same as that noted in the title block.
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8
EEE BROKEN CUT > create the BB cut

@the frame of the broken section BB > Positioning of views > F
Position Independently of Reference View > Move View Right of Section AA

@BB broken section frame > BB section object > Add View name
| BN
2x on‘writing > Erase scale, just leave cut BB > OK Reposition text if needed.

Ko 80
~ % ~PROJECTED VIEW (behind FRONT VIEW) > create the
right view

g
~ T YPROJECTED VIEW > create left view

Coupe B-B

August 2010 - 104 -



Machine Translated by Google

Introduction to Computer Aided Design (CAD)

EPFL

|
~ 2x on the frame of the left view (thus the one on the right) > the frame turns red

BN
EﬁE BROKEN CUT > create the CC cut > Procedure: zoom in on one of the
[(un a
holes > the‘center > zoom out and 2x outside-the block, taking care to pass through the
center of the part (indicated by the symbol ) > place the segfion at the top left of the work
plan.

@CC broken section frame > Positioning views > Position independent of
reference view > Move CC section in work plane.

@the broken section frame CC > Section Object CC > Add View Name > Clear
Scale, just leave CC Section > OK Reposition text if needed.
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| Bs
~ 2x on CC cup frame > frame turns red

éh . . .
¥ PROFILE OF THE QUICK CUT VIEW (behind CUT VIEW) > create a rectangle which passes through the axis of the block and
surrounds it as shown in the figure below.

L2
" the 2 dotted lines perpendicular to the axis of the block > F2 key on the keyboard (this key is used to hide the lines
selected)
Coupe C-C Coupe C-C
Dessiné 16.07.2009 jennifer gasparoux Echelle
O s o Contréle 1 '1
EPFL CARTRIDGE > the Epfl cartridge —
appears, modify the name if necessary. (rempm——— O rpee— G@
Nomenciature sép de méme N' O Matiere EN AC-AISi7Mg0.3 T6 | origine Format NG Teulios Feulle N
Nomenciature sép de N* diff ] Masse 091 kg Remplace A3 1 1

(AW ~ BLOCROULEMENT |
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Dimensions of the different views

Front view

) 4’48
" 2x on the front view frame > the frame turns red

[+
Using the DIMENSION tool, dimension the front view as shown in the figure.

62 102
@
|
|
|
|
g
I
-
|

31 02

N
r

10
o
\¥

To align dimensions (such as 10 and 50):

10 50 005

| BN
@ on the dimension to be aligned > Alignment ~ the rating of
> reference > Ok (the 1st dimension aligns with the second)
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82
On the left and right views, modify the center lines of the threads by following the same - N

procedure as that followed for the DISC SHAFT part (pages 51, 52)

Right View
[ 88
= 2x on the frame of the right view > the frame turns red
[+ @
Using the dimension tools ( DIAMETER DIAMETER "3, ANGLE DIVISIONS and M

DIAMETER DIAMETER), dimension the view on the right.

Note: To interrupt the dimension circle @60: before confirming
the position of the dimension, when it is
Sl
still red in color, move to -~ white squares and
obtain the desired interruption.

Left view
[ un)
" 2x on the frame of the left view > the frame turns red
: : : [ "y 2
Using the dimension tools ( DIAMETER DIAMETER "~ ANGLE DIVISIONS and v

DIAMETER DIAMETER), dimension the view on the right.
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Section A-A
R
" 2x on the frame of the AA cup > the frame turns red

Dimension section AA using the following tools:

4
% QUOTATIONS

a
—

v DIAMETER QUOTATION
» ROUGHNESS SYMBOL

®

3

REFERENCE

8 B

¥ GEOMETRIC TOLERANCES

e

¥ ATTACHED TEXT

To insert the dimension of the 45°x1 chamfers

&l
" "+« CHAMFER DIMENSIONS > Tool Palette
BN
> select angle x length > " the chamfer in question > Place the dimension
BB Cup
.,

~ 2x on BB cup frame > frame turns red

-
+—

[+
Using the DIAMETER DIAMETER and DIAMETER DIAMETER tools , dimension the BB cut as
you learned in previous tutorials.

_\(

D43

[ /]0.05]A)

70
66

R Max 0,3 N6

P~
.
r~
-

Coupe A-A

/112

D667

1(2x)¢

Coupe B-B
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CC Cup

B
" 2x on CC cup frame > frame turns red

[+
Using the DIMENST®N tool, dimension the depth of the holes (15).

To insert the thread dimension

BN BN
~ M, TAPPING DIMENSION > - tne tapping in question > Place the
dimension (by default, the diameter and the depth appear with a different color)

To reverse the orientation of the hatch

@ the hatch > Properties > Fill > Angle > select -45° > Ok

Finally :

* Move views and dimensions so that there is no overlap

* Insert general surface finish > ROUGHNESS SYMBOL

* Insert General Tolerances >

* File > Save

T_ TEXT:

%\u 4 . Coupe C-C

Y /)

Tolérances générales:
NF EN 22768 - m
(IS0 2768 - m)
Nickelage chimique
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1 | 2 | 3 | 4 [ 5 | 6 | 7 | 8
N 70 5
A ; 13 - %
N ' i =
i e N e — -—-—- — 1 _
N +,
[
=
g S | B )
B =
R Max 0.3 I\%/
~ D E o NN -
Gﬁllpe Aef Ccupe B-E
c jH
m A
| he b
|
D b . :
e ) i &
Li=] - 1
I A ' A
= \"9 q} P 4
E o B
@Q‘? + C Na
10 50 rens v/ i\/3
] T 16.07.2009 jennifer gasparcux ==
M - 11
Toléranses geénérales - - y - |
NF EN 22768 -m = LT — |a@-
F (150 2768 - m) 5= L — A3 | 1 | 1
Nickelage chimiqus :( )ﬂ: "~ BLOC ROULEMENT |
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11. BASIC EXERCISE 7: SCREW RING

FINAL RESULT
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Start Menu > Part Design > enter part name: SCREW RING > OK
File menu > Save > L:catia > file name: VIS RING > Save

CREATION OF THE SPAN & 40 mm

Définition de lextrusion [ ? /X

the ZX plane in the tree structure > - Ty:‘ i Im:gueu -
SKETCH &3] ANNEAU VIS 3D N e
(=8 — < Plan xy [Fascestinction. | |
./ G) CIRCLE > E:D .. @ ProfilfSurface
- the cénter on the origin > any — 7 Plan yz Selection : [T WN 5|
diameter (circle turns red) e o il ¢ ] epaissi
, |
!:‘9 EL Elj:] h '_‘: Corps prinCipaI [[] Extension symétrique
CONSTRAINTS > set dimension > 2x onthe Inverser la direction_|
diameter value > enter 40 > OK i_@ _
—@ Set géométrique.1 Rz
@ 0ok I CAmder] Apercu I

s ":IJ LEAVING THE WORKSHOP

@

@' EXTRUSION > Type : Length > enter 5

el
N

okay
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CREATION OF THROUGH HOLE @ 24, BLADE @ 26 prof. 2mm

* @ HoLE

du trou E‘@
3] ANNEAU VIS 3D e | e | D e |
- — Plan Xy IJusquau suivant ﬁ
~ the face of the @40 staff (the hole appears in red) — .~ Plan yz vansre: [ T8 |
=)
—.—7 Plan zx I——“ e
E]} . . '.,:" T — : Offset : Omm Edtlondelesq;sse
-’ tab: Extension: Up to next > Diameter : 24 mm PS principal - ¢ = g
@ _ I Direction Fond
T T e o =
-]] @ - 4 Perpendiculaire 4 la surface nde[Tz0des P
e Hr?we tab : Blade > Diameter : 26 mm > Depth : 2 A Esqu.sse 2/ : ] ]
A —% Set geometnque 1 - @ ok | @ annuer | |
" OK > 0K
Définition du trou E|
. . Extension | Type | Définition du taraudage | It:$ ANNEAU VIS 3D
Note : if the face chosen to position oo <] .
a hole is circular, the hole defaults to £ Plan xy
the center. To change this location. It is Paramétres -
then necessary to dimension the center Diometre ; ~[26mm & _| Plan yz
point of the hole: Profondsur ;| 2mm — .~ Plan zx
Edition de 'esquisse ¥
9 @ Paint d'accrochage "'lza Ccrps prinC|pa|
- @ Extrémité O pileu
T‘@ Extrusion.1
— @ ok | &amuer | | r@ Ir_Qu_,_l
i'-|.:;.:5}11 Esquisse.2
—@ Set géométrique. 1
inner edge
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& ANNEAU VIS 3D

@ mv EDGE FILLET it

e — = Plan yz

" on the inner edge (see previous drawing indication) > Radius > Enter 1 mm — .~ Plan zx

!_1} okay r{é} Corps principal

T—EI Extrusion.1
Trou.1

6 TAPPED HOLES M4 *"l__"'?'\ Esquisse.2
. &) Congé aréte.1
~ © HoLE

—E Set géométrique. 1

Edge fillet = rounding

~~ the same face as for the previous hole (the hole appears in red)

Topological operators error message > OK

(When a hole is requested, the default hole parameters correspond to those entered during the last hole, this error message appears
when the dimensions of the hole "overflow" the part)

" on the arrows and move the hole at 2 o'clock, so that it rests on the face of the staff.

23 ANNEAU VIS 3D
“~ Extension tab : Up to next

— == Plan xy

== Plan yz

. == Plan zx g
> Diameter : 4mm =i Corps principal

+-(7) Eisona

, OFfet ¢ '—EUMIT! Edtion de Fﬁ&lsu
@ Trou.1 / Direction Fond
#-[7, Esquisse.2”

Inverser r
&) Congé aréte.1

S perpendiculare & la suface

L.
" Type tab : Simple

[ H

—_——

- e | g |

-
—@ Set géométrique.1
August 2010
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| =8

- tab: Thread definition > activate: Tapped > Type : Metric Coarse Pitch > Ref. thread : M4 >

Teacher. thread : 5 mm > activate: Not straight >

| o KL
*~ Extension tab > g Editing the sketch

I ] 1]
(7 ﬁ:f, CONSTRAINTS > !T the horizontal axis H and L

e

>2x " on the dimension value > enter 16 > OK

[ 8N [ B
" on the vertical axis > hold down the Ctrl key and >
release the Ctrl key

1
[, §f SELECTED CONSTRAINTS IN A DIALOG BOX

[]
[ Coincidence > OK

-y l.'T_'l LEAVING THE WORKSHOP

“ onthe point > set the dimension

— = Plan xy
—. Plan yz
— . Plan zx

=14 Corps principal

23 ANNEAU VIS 3D

23] ANNEAU VIS 3D

<= Plan xy

. Plan yz

<= Plan zx i
I‘f‘ Corps princip:al
| @ Extrusionil

Trou.l |
b—m Esquisse.2

“~ on point (two selected items turn red)

Contraintes E@
[ Distance Ol Fixe
O 4 Calncidence
] m}
O a
o = ]
0 o
[ i}
0 0
(]
OK @ Annuley
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CIRCULAR REPEAT

“~" Hole.2 (= last hole created) in the tree structure (the
hole turns red)

® & CIRCULAR REPEAT

' tab: Axial reference >

Settings: Full Crown >

Instances : enter 6 >

I .

“~ the face of the ring @40 >

Reference direction :

enable: Keep specifications

./ okay

APPLICATION OF MATERIALS

&3] ANNEAU VIS 3D

— .~ Plan xy

—.— Plan yz

— = Plan zx

*"{i@ Corps principal
(7] Extrusion.1

T_ Trou.1

f@ Esquisse.2

ﬁ] Congé aréte.1

"@-

i‘m Esquisse.4

> Répétition circulaire.]

—@ Set géométrique.1

ANNEAU VIS 3D
.= Plan xy

Bibliotheque (Lecture seule)

Définition de la répétition circulaire

Référence axiale I Définition d'une couronne
Paramétres: !Ccuonns entiére L]
Instances ! |6 =
Espacement angulaire : | <1 - fx)!
Angle total : [ E
- Direction de référence
Elément de référence:|Extrusion.1\Face.
Inversion de la direction l
Elément & copier
Obijet d'ancrage:|Trou,2
I Conserver les spécifications
Plus>>
9 o | 9|

[ Catalogue de matériaux par défaut

Acconstruction | Acaméioration | Ac cémentation f ntruration | Acoutis | Acoxydables | Fontesgrses |Fomtessi [ »

B ofa)

o g HEE O

./ & APPLICATION OF MATERIALS 2c a5 TN C45PbKsN  C50GRD

*~ Ac construction tab > “ocas n n n n

-:D . . ‘ . DCol oD 11 E295 M 1590-65

“~ in the Main Body tree view (part outline turns red) n n n

L _ !

" Apply Material > OK : ™ N N o

) *Matériau’ =2 C 45 Dlier i

File > Save —@ Set géomeétrique.1 S o Mooy Femer
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12. BASIC EXERCISE #8: CYLINDRICAL WEDGE

FINAL RESULT
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Start menu > Part Design > enter the name of the part: CYLINDRICAL SHIM > OK
File menu > Save > L:catia > file name: CYLINDRICAL WEDGE > Save

SPAN @ 30 mm

[ BN KL @
“~ the ZX plane in the tree structure > -/ E—’- SKETCH

Y ® cree> U
©

KL
the center on the origin > ' any diameter (the circle turns red)

©

E}v CONSTRAINTS > set dimension > 2x on the diameter value > enter 30 > OK

./ & LEAVING THE WORKSHOP Définition de ['extrusion @@
43 CALE CYLINDRIQUE [
-/ El EXTRUSION > Type : Length > — 7 Plan xy Longueur ; [TEHEE =
enter 36 > OK — 7 Plan yz fpac e coloctiny |
ProfiljSurface
e Plan X Sélection : Esquisse. 1 %I
w—%@ Corps principal [ Epaissir
.‘? _ _ [ Extension symétrique
‘ E Equisse.l Inverser la direction I
— £ Set géométrique. 1 s
@ ok | Sannder | apercu |

-

August 2010 -119 -



Machine Translated by Google

Introduction to Computer Aided Design (CAD) EPFL
HOLE @ 30 mm
a 3] CALE CYLINDRIQUE otinon g ro - 2K
~ @ HOLE [~ & Plan Xy Extension I Type | Définition du taraudage |
[— 27 Plan ¥z [Jusqu‘au suivant L]
o &
KD — 2= Plan 2x ol Eﬂ
~ afl i i -3 Corps principal o =Ll
a flat face of the cylinder (the hole appears in red) @ ps princip e —
-]:] T- - ESCI uisse.1 Direction Fond
./ . . . . ’ I8 Inverser | : -
Extension tab : Up to next > Diameter : 25mm > r@- ; 3 Perpaniculars & suface
OK > OK *—m Esquisse.2 o -
—@ Set géométrique.1 : 2 Annuler | |
H i - o &

APPLICATION OF MATERIALS

[(Catabogue de metériaus par défaut

e

KL oy : :
ac Ac amé | & Initrwration | Acoutis | Acinoxydables | Fontesgrises |Fontesst < | »
-/ & APPLICATION OF MATERIALS | e =
3] CALE CYLINDRIQUE
[~ Plan xy
ID -j] <= Plan yz
p— Ac construction tab > oy 2 C 45 —‘gPlan - 115MIPb 30 2c45 casN Ca5PbK+N CS0GRD
b; HEdOdAd
E:JD . . . . @ c22 DCo1l DD 11 E235 M 1590-65
in the Main Body tree view (part outline turns red) T* n n n n
Fﬂ Esquisse.2 MSH-AC 42.2 P 355N S235RC S235RG1 5235 R G2 i
B Matériau’ =2 C 45
@ . L5 set odomrique.t N el ol el o o
Apply Material > OK =
- ] 0K I AE!MKQEU I Fermer
File > Save
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Note: The Cylindrical Shim can also be constructed in one step, using the Thicken option of the Extrude tool .
Do this exercise by opening a new file (Start > Part Design) which you will call CYLINDRICAL WEDGE 2.
CYLINDRICAL WEDGE 2
© . o @
~/ the ZX plane in the tree structure > -~ SKETCH
O @, cIRCLE > © the center on the origin >
E; any diameter (circle turns red) 2lx
r—Premiére limite ] Coecondelimte ——————————————
E:D Type : |J.ongueur it I Type : ILnngueur 'I
- EL CONSTRAINTS > set dimension > 2x Longueur : - [36mm B fonguer:  [om =
Lirmite Pas de sélection Limite : Pas de sélection
FB on the diameter value > enter 30 —ProfifSurface —————————— [~ Direction
> okay Sélection : IEsqLﬁsse.l @I '3 Perpendiculaire au contour
!:D I3 Epaissir Référence :[Pas de sélection
T Inverserlecote || — Extrusion Fine
~/ B8 LEAVING THE WORKSHOP [] Extension symétrique Epaisseurt: | 2.5mm
Inverser la direction I Epaisseur2: | Omm
[[] Fibre Meutre [ Extrémités relimitées
© ], EXTRUSION > Type : Length > —
enter 36 > activate the Thicken tag > the [y 9 o | & sonuer] e |

window expands > Thin Extrusion >
Thickness 1 > enter 2.5mm > OK

File > Save

Note: thickness 1 corresponds to inward thickening, thickness 2 corresponds to outward thickening.
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13. BASIC EXERCISE 9: INT LID

43 COUVERCLE INT

— 7 Plan xy

— .+ Plan yz

— .+~ Plan zx

f{‘@ Corps principal

— W 2C45

#—@ Extrusion.1

*'W’i: Esquisse.1

i-.? Extrusion.2
4 Esquisse.2

v

P
' rﬂ Esquisse.3

—@ Set géométrique.1

—E Matériau’ =2 C 45

FINAL RESULT
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Start menu > Part Design > enter the name of the part: COUVERCLE INT > OK
File menu > Save > L: catia > file name : COUVERCLE INT > Save

SPAN @ 40mm LENGTH 4mm

© | O &
the ZX plane in the tree structure > SKETCH
9 Q CIRCLE > ~ igi ~ i i
- the center on the origin > any diameter (the circle turns red)
KL
s EL CONSTRAINTS > set dimension > 2x EI”]' on the diameter value > enter 40 > OK
U
-~/ B3 |EAVING THE WORKSHOP
Définition de l'extrusion
L. éj [~ Premiére limite
ol él EXTRUSION > Type : Length > enter COUVERCLE INT 4 :Type: ILongueur L]
4> 0K o 4 Plan Xy & Longueur : |4mm =)
s Plan ‘,IZ Profil/Surface
[~ = Plan ZX | Sélection : [Esquisse. 1 @
i | Epaissir
!‘@ Corps principal 1
- _ [] Extension symétrique
Inverser la direction I

#-l__ﬁ?*, Esquisse.1
—@ Set géometrique.1

Plus >>|

3 arnuler | apercu |
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SPAN @ 29mm LENGTH 12mm

a flat face of the cylinder

@

SKETCH

Y@ crees U

@B

I'IJ LEAVING THE WORKSHOP

@B

@

@v EXTRUSION > Type: Length >
enter 12 > OK

the center on the origin > !:—I/] any diameter (the circle turns red)

K1
EL CONSTRAINTS > set the dimension > 2x on-the diameter value > enter 29 > OK

23| COUVERCLE INT
— = Plan xy
— = Plan yz
— .= Plan zx

I"@ Corps principal

Extrusmn 1
Ti— % Esquisse.1
#—D Esquisse.2
-‘@ Set géometrique.1

Définition de l'extrusion E][ZI

Premiére limite

—ProfilfSurface -

[ Epaissir

e

[] Extension symétrique

Inverser la direction |

Type : [Longueur El
Longueur ; | 12mm =

Sélection : [Esquisse.2 @I

Plus >>|

Sannuer | - |
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HOLE @ 25mm

!:E] < HOLE

@

the face of the @29 staff (the hole appears
in red)

(=

Extension tab : Up to next >
Diameter : 25mm > OK > OK

APPLICATION OF MATERIALS

¥
!-']; & APPLICATION OF MATERIALS

E3]2C45

~* Ac construction tab >

EI/] in the Main Body tree view (part outline turns red)

o Apply Material > OK

File > Save

&3] COUVERCLE INT

— = Plan xy
— <= Plan yz
— 2 Plan zx
L & Corps principal

Extrusmn 1
T#- . Esquisse.1
Ti— -#1 Esquisse., 2

*‘D Esquisse. 3 :
—@ Set geometrlque 1

tion du trou

| Type | Définition du taraudage |

iJusquau suivant lJ
Dismétre: |25mm  [5] ﬁ_l
=
Offset : Omm Edjition de l‘es&lsjse
L
| Direction Fond =
Inverser I I m —]
I3 perpendiculaire & la surface
I

@ OK I @ annuler | oo |

&3] COUVERCLE INT
— 2= Plan xy
—«— Plan yz
— 2 Plan zx

€22

‘Ca!alngje de matériaux par défaut
AC construction | Acamélioration | Ac cémentation [ nitruration | Acoutils | Acinoxydsbles | Fontes grises ]Fonresq »

115MnPb 30

MSH-Ac 42.2

a

2C45 C35N C45PbK+N C50GPb

(1}

DC 01 oD 11 M 1590-65
P 355N S235RC S235RG1 S 235 R G2

L o7 i #
*Matériau® =2 C 45 :
[ Lier aw Fichier

—@ Set géométrique.1

o I
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14. BASIC EXERCISE 10: EXT LID

&3] COUVERCLE EXT
— .~ Plan xy

— 7 Plan yz

— =7 Plan 2x

i"@ Corps principal

— W 2C45

*? Extrusion.1
w;;l Esquisse.1

=

i"? Extrusion.2
1 Esquisse.2

v

= [p) Trou.1
[\ Esquisse.3
=-[g) Trou.2

~E * Matériau’ =2 C 45
— ¥, Set géométrique.1

FINAL RESULT
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Start menu > Part Design > enter the name of the part: COUVERCLE EXT > OK
File menu > Save > L: Catia > file name: COUVERCLE EXT > Save

REACH @ 74 mm LENGTH 4.9mm

@

. R
the ZX plane in the tree structure > SKETCH

@B

Q, CIRCLE>  “~ the center on the origin > — any diameter (the circle turns red)

B

£
AN

KL
Eb- CONSTRAINTS > set dimension > 2x “~ on the diameter value > enter 74 > OK

(s g — =
-, tIJ L EAVING THE WORKSHOP Définition de I'extrusion @
Prermiere limit
- &3] COUVERCLE EXT 5. (NI — 5]
=1 EXTRUSION > Type: Length > enter — 2 Plan xy Longueur ; | 4,9nm
4.9 > OK ki
_g Plan YZ Profil{Surface
'_5’ Plan zx Sélection ! Esquisse. 1 El
[[] Epaissir
I'-C;ﬂ} Corps principal ezerezal
[] Extension symétrique
r@ _ Inverser la direction |
#—Fﬂ Esquisse.1 —
S l
—% Set géometrique.1 @il I
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REACH @ 47mm LENGTH 5.1mm

~~ aflat face of the cylinder

i

@ G

@B

@ @&

|_BN
®v CIRCLE> - the center on the origin >

I’I.'l LEAVING THE WORKSHOP

Izlv EXTRUSION > Type: Length > enter 5.1 (reverse
direction if necessary) > OK

D
“~ any diameter (the circle turns red)

KD
E:L CONSTRAINTS > set the dimension > 2x on-the diameter value > enter 47 > OK

23] COUVERCLE EXT
— =7 Plan xy
— . Plan yz
— .7 Plan zx

I“@ Corps principal
Extrusmn 1
T#- 7% Esquisse. 1

i—D Esquisse.2

—@ Set géométrique.1

Premiére limite

Type |Lnngueur _:J

Longueur : |S,1mm @
ProfilfSurface

Sélection : ]Esquisse.z @

[[] Epaissir

[] Extension symétrique

Inverser la direction I

Plus > |
| @ annuer | i |
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HOLE @ 29.5mm

@

@) HOLE

@

the face of the @47 staff (the hole appears in red)

B

Extension tab : Up to next > Diameter : 29.5mm >
OK > OK

4 THROUGH HOLES @ 7mm

T @ vowe
>,

the face of the @ 74 staff (the hole appears in red)

Topological error message : OK

- on the arrows linked to the hole and move the hole
to 2 o'clock (on the staff face)

23] COUVERCLE EXT
— .= Plan xy

— .= Plan yz

— <7 Plan 2x i
'—Efg Corps principal . '
=-¢p ) Extrusion.1
| A Esquisse.l]

& COUVERCLE EXT
— .~ Plan xy

— .~ Plan yz
— <= Plan 2x

T

—@ Set geometnque 1 r

'—@ Set geometrlque 1 2 '

Extension | Type | Définition du taraudage |
|).vsqu'au suivant LI
Diamétre :  |29,5mm E Jé_l
Offset IM—E Edition delesc:;sse
2 |
Direction Fond i
Inverser | [Limit: |
3 perpendiculaire 4 la surface A I—E ‘
| y
@ ok | Sannuer| oo |

Définition du trou

[ Type | Définition du taraudage |

Jusqu'ay suivant _J

w2
|
T Ef
e e —
Offset ¢ omm Edition de l'esquisse

&
- Fond
Inverser | i =

"4 perpendiculaire 4 la surface

Direction

’0—0KI Onmulerl Eiasei |
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y Extension: Up to the next > Diameter : 7 mm ¥y

©
©

Type tab : Simple >
Extension tab >

!-j/j %v CONSTRAINTS >

odds > 2x e on the dimension value > enter 30 > OK

©

on the vertical axis > keep the Ctrl key pressed and two
selected elements turn red) > release the Ctrl key

!:B % SELECTED CONSTRAINTS IN A DIALOG BOX

8 Coincidence > OK

!_3/3 I'i'l LEAVING THE WORKSHOP

©

okay

UH

SlcowverRcEEBXT

£ Plan yz

[T Plan z:x
;Corps:principal
Extrusion.1

&

Editing the sketch

@ the horizontal axis H and @

on the point > put the

©

on the point (the

ICOUVERCLE EXT
== Plan xy

= Plan yz

= /= Plan zx

=-{83 Corps principal
Extrusion. 1
{ Esquisse. 1

? Extrision.2
F Esquisse.2

Trou.1
@ Esquisse. 3

S
@ Esquisse.5

— B set géométrique. 1

August 2010

- 130 -



Machine Translated by Google

Introduction to Computer Aided Design (CAD)

EPFL
CIRCULAR REPEAT

EI; Hole.2 (= last hole created) in the tree structure (the hole turns red)

EI; {}‘ CIRCULAR REPEAT

" Axial reference tab : > Parameters: Entire crown > Instances : enter 4 > Reference direction : worn @ 74 > @ the face of the

activate: Keep specifications > OK

@ COUVERCLE EXT Définition de la répétition circulaire
— /7 Plan xy Référence axiale l Définition d'une couronne
/=7 Plan yz Paramétres: ICnurnnne entiére _'J
=7 Plan zx Instances : I“' E
L gl inci
$92 Corps principal Espacement angulaire : | ] ﬁcbl
L o =
- E- Angle total : | tldeg
Squisse,
bt Cj se.l Direction de référence -
.‘? E?(U’USIOH.Z Elément de référence:|Extrusion. 1\Face.
i #\Esquisse.2 Inversion de la direction |
== Trou.1 ément & copi
‘ Elément & copier
[\ Esquisse. 3 Objet d'ancrage:| Trou.2
"@ - [[] conserver les spécifications
[\ Esquisse.5
— {3 Répétition circulaire,1 @ ok | @ annuer |
—@ Set geometrique. 1 o

August 2010 - 131 =



Machine Translated by Google

Introduction to Computer Aided Design (CAD) EPFL

APPLICATION OF MATERIALS

KL o%

./ & APPLICATION OF MATERIALS

7 - e
Ac construction tab >

B

in the Main Body tree view (part outline turns red)

\_/ .
Apply Material > OK
COUVYERCLE EXT Bibliothéque (Lecture seule) EL = gj
o Plan Xy |Cata|m]us. de matériaux par défaut l]
Ac construction | Ac amélioration | Ac cémentation § nitruration | Ac autils | Ac inoxydables | Fontes grises |Fantas 5 _L»_
115MnPb 30 2C45 C35N C45PbK+N CS0GPb
DCOo1 DD 11 M 1590-65
@) Trou.l
#-[/, Esquisse.3
w ;’DU.Z MSH-Ac 42.2 P 355N S235RC S235RG1 S235IR G2 [
. [, Esquisse.
> X
File > Save | o Reodiion o ™ N N N »
b 4 »
=g . .
Matériau” =2 C 45 e ahre
-—@ Set géometrique.1 I carrm—|
(S
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15. BASIC EXERCISE 11: HALF-TORUS

% | DEMI-TORE 3D
27 Plan xy
<=7 Plan yz
£ Plan zx
r{@ Corps principal
— @ 2C45
I"w Révolution.1
#- 7 Esquisse.1
-—@ Chanfrein.1
—5 *Matériau” =2 C 45
—@ Set géométrique.1

FINAL RESULT
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Start menu > Part Design > enter the name of the part: HALF TORE > OK

File menu > Save > L: Catia > file name: HALF TORE > Save

HALF TORUS @2mm

KD | BN y'f
“~ the ZX plane in the tree structure > E_L SKETCH

|_BN | BN [ _m
St ®v CIRCLE > -~ the center on the origin >
xo o8
Ehv CONSTRAINTS > set dimension > 2x

|_BN :

AXIS > draw a horizontal axis line above the circle.

|_ma ] ,
./ beside the view

| BN |
N/ BSL CONSTRAINTS > ./ the horizontal axis H
KL | a8
and  “~ the axis line > set the dimension > 2x on the‘value
of the dimension > enter 12 > OK

| BN 1.
./ B3 LEAVING THE WORKSHOP

any diameter (the circle turns red)

on the diameter value > enter 2 > OK

&3 DEMI-TORE 3D

—.— Plan xy

—.—7 Plan yz |

— .~ Plan zx

=-{9% Corps principal

&
?—t Repere

?" GB Géometrie

—@ Set géomeétrique.1

#-[]f Contraintes

Edition de contrainte

Valeur| 12mm Bl Oitesure]
o 8

Plus>> |
@ oK I JAnnuIerl

August 2010

- 134 -



Machine Translated by Google

Introduction to Computer Aided Design (CAD)

EPFL

- # rRevoLuTION

First angle: 179 deg >
Second angle: 0 deg >

Profile/Surface > Sketch.1

Axis > Sketch Axis
(Normally the axis of the sketch is selected automatically)

>0K

17pe

@ DEMI-TORE 3D
— .~ Plan xy
— . Plan yz

b—@ Esquisse.1
—@ Set géométrique.1

Définition d'une révolution @

Limites
Premier angle : | 179deg
Second angle : | Odeg 2

ProfiliSurface

Sélection : [Esquisse. 1 @

[ Epaissir le profil

Axe
Sélection : [Axe de sketch
nverser la direction |
Plus>> |
A |
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- & CHAMFER

Mode: Lengthl/Angle >
Length 1: enter 0.2 >

Angle : between 45 >

Objects to chamfer: the 2 ends of the half torus

&3] DEMI-TORE 3D

"@ Corps principal

(Ctrl key pressed to select 2 elements)

> okay

APPLICATION OF MATERIALS

KD o%
./ & APPLICATION OF MATERIALS

_mN
" Ac construction tab > ./ 2C45

| B8
“~ in the Main Body tree view (part outline turns red)

BN
" Apply Material > OK

File > Save

— 7 Plan xy
— .~ Plan yz
— .~ Plan 2x

wlﬂeamlutm.l

;’,,;' 1 r . 1
Materiau =Aucun

—@ Set géométrique.1

Bibliothéque (Lecture seule)

Mode : |L0ngueur!f.°-ngle Ll
Longueur] |D;2mm %
angle : [45d=g 2
Objets & chanfreiner:
Propagation : |Tangence LI
[ tnverser

‘0 OK I @ Annuler | |

| catalogue de matériaw: par défaut =]
Ac ion |A< | Ac ion  nitruration | Acoutils | Acinoxydables | Fontes grises |Fontes s | o |
& DEMI-TORE 3D
— = Plan xy
=7 Plan yz 11SMnPb 30 c4 C 35N C45PbK+N CS0GPb
— .= Plan zx
=143 Corps principal
" 2 C 45 c22 DCco1 oD 11 E295 M 1590-65
Révolution.1
F; Esqmsse 1 n n E n n
Chanfrein.1 —
‘ L. ‘ MSH-AC 42,2 P 355N S235RC S 235 R G1 S235R G2
Matériau” =2 C 45 N
L5 set géométrique.1 o BN o BN o BN o o
[ Lier au fichier
] oK I | Fermer |
[
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16. BASIC DRILL 12: SPRING WASHER

53] RONDELLE RESSORT
— ... Plan xy
— .. Plan yz

i—{@ Corps principal
— g $35512G3
# E r I I- I

LLE

M;f Esquisse.1
—E5f ' Matériau® =S 355 12 G3
—@ Set geométrique.1

FINAL RESULT
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Start menu > Part Design > enter the name of the part: SPRING WASHER > OK
File menu > Save > L: Catia > file name: SPRING WASHER > Save

L o @
~ the ZX plane in the tree structure > SKETCH

AXIS > draw the horizontal axis line, passing through the origin.

Using the construction tools, draw the profile of the spring washer respecting
the dimensions given in the image on the right

BN 1
~/ B3 LEAVING THE WORKSHOP

=H__

..................... T |”P
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) #® revoLuTion

First angle: 360 deg >

Second angle: 0 deg >

Select : Sketch Axis > OK

23] RONDELLE RESSORT
— ..~ Plan xy

— ~~ Plan zx ;

=343 Corps principal
"Matériau’ =Aucun

=& Révolution.1
*‘rﬂ Esquisse.1

—@ Set géometrique.1

@ RONDELLE RESSORT

— ... Plan xy

— .. Plan yz

— .2 Plan 2x

o Corps principal

" Matériau” =Aucun

: *} Esquisse.1
—@ Set géométrique.1

~ Sélection : [Esquisse, 1 ;E_J

T Sélection : |Axe de sketch

Définition d'une révolution EIE]

r Limites
;Prernl‘er angle : |360deg @
|Second angle ; |Odeg E

ProfiliSurface

| Epaissir le profil

[ Axe

| Inwerser la direction |

Plus>

@ OK ] ‘Anndarl Apercu ]
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KL o3
b d APPLICATION OF MATERIALS
> W,
Ac construction tab > - §355J2G3
>
in the Main Body tree view (part outline turns red)
v, .
- Ap p |y Materl al > OK Bibliothéque (Lecture seule) E] @
|Cata|ngue de matériaux par défaut j
Ac construction | Ac amélioration | Ac cémentation | nitruration | Ac outils | Ac inoxydables | Fontes grises |Fontes s _|_>
I I I I I _Li
11SMnPb 30 2c45 £ 35N C 45 Pb K+N CS0GPb
... Plan xy c22 DC o1 E255 M 159065
— ~Plan yz
77532 Corps principal
= MSH-AC 42,2 P 355 N S235IRC S 235 R G1 5235 R G2
? 355’J2 (?:3
Matériau’ =S 355 J2 G3 n
[ w Révolution.1
N Esquisse. 1 S 35512 G3 5t 35 TPS-AC 52.3
—@ Set geometrique.1 . -
[ Lier au fichier
-] OK e | Fermer |

File > Save
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17. EXAMPLE OF TEST

| 2 | 3 4 5 | 6 |

-
[=-]

n B > (@2 A
’ o 105
am 23 T
B .
25 =
—

15

45
2
e

| FT ——r 1
. 1 /| S | [ 11 11 1 | I
o
@10 " 2 : f L]
A s s M
C 53 =
Coupe A-A
150
N 130 201
25 =01 5
D %@ \’a
@z _é%
— ) T s T e
- g 25 h 9"\“ @ 12 H7
Q (?ﬁ:/ 05 Q
b8
E 1
| Cwend. 25.04 2008 Jennifer Gas parou e
= 1:1
Rayons non cotés R5 TP RS =
F N9/ Tolérances générales selon |SO 2768 -m kg A3 I 1 1
Chanfrein 0,1...0,4x45° BRAS DE LEVIER e

|
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2 | 3 | 4 | 5 | ] 7 8
I~
] ¥ 664
i i i 26 =1
4x 26 4 traversant
\ Mo,
= © 1 [ |
5 % | {T} €1J =k -
o~ [1} | g o9
~| @10 o " & | < S
4
4 I @ {D [re) |
72 104 - l
ic"n
/ 1 40 L
B {) I | | e - -  ©
| | ot v/ &
AR ] g
.{ | 1 L1l f
& 3 - M9 o
L 105 "
Tolérances générales: ISO 2768-m N9
= 115 o Chanfreiné 0,3 ... 05 x 45°
ot 10114/2008 MAWAEBER Btk
- - e 1:1
LBS ODUI'bUI’BS sans QOtGS Lq@mr g [TV Aolar NOX :::"'- ot Pl b
sont d'un rayon de 10mm. - i 1 1
Fusée droite
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18. BASIC EXERCISE 13: 3D BEARING ASSEMBLY

FINAL RESULT
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Start menu > Assembly Design > enter the name of the part: ASSEMBLAGE_PALIER > OK
File menu > Save > (default location, or as indicated) > file name: ASSEMBLAGE_PALIER > Save

[ FCATIA VS potie stuadiant -
[ Gomarrer  Eichier  Edbion

fifchoge fpserion _ Quts  hnalyse Fendtro e

-,

~ File > open > select all parts of the assembly while holding the key
Ctrl pressed (9 parts: gear wheel, spring washer, half torus, inner cover, outer
cover, cylindrical wedge, bearing block, disc shaft, screw ring)

2

" Open

Rl
~“ Window > Horizontal Tile

All assembly components are visible

A 4

.
DEEe By R/ MA@l BE4nqasB06H '8 238 ™

Assembly window
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Inserting parts into the assembly:

To move each part into the assembly:

Example for the BEARING BLOCK :

|_BN
“~"BEARING BLOCK in tree view (selected item turns red)
> Holding the selection, drag the element into the assembly

Repeat the operation for all the components

' f?) Corps principal

 CTnssime

|%7»x~=- BLAGE_PALIER.
-Applications

R

L

L

Once the components have been inserted into the assembly, it is no longer necessary to keep the windows open: close the component

windows, keep only the landing assembly window.

Component positions :

After insertion, the parts of the assembly are superimposed on each other.

Using the manipulation function, move the components to distinguish them from
each other:

%, Pépla lon I'a

er st

> choice of a translation axis

> Move the pieces along the chosen axis
>0K

| 8
~ &“ Handling
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Fixing the basic component:

It is necessary to fix the main part:

| 2 . a8
cj?,;l Fix > . select : DISK SHAFT
(An anchor appears on the drawing)

Inserting catalog parts:

K
" Rigid single row

| & | B
> Catalog > 2x

marbles 0

Bearings > 2x

In the list at the bottom, presenting the characteristics of the bearings, choose (2x
The BSA1116219200 bearing (reference no. 22 in the catalog)

This is a 6005 type bearing: y int: 25mm; y outer: 47mm; width: 12mm
>0K

> Close catalog

Duplicating a part:

Assembly requires 2 bearings. To duplicate the component :

|_BN
> BSA1116219200 in the tree view (selected item turns red)

> Drag the element into ASSEMBLAGE_PALIER while holding down the Ctrl key. The

bearing reference should appear twice in the tree structure.

The duplicated element is often superimposed on the main element, the Manipulation tool allows you

to separate the different elements.

|_BE
~ @t_ﬂ Handling >

Navigateur de catalogue:STANDARD_COMPONENTS 2ix

ol f el ]

Sélection | Rigide & 1 Rangée de filles

BSA1116212400 (Stastut inconnu)
BSA1116521200 (Statut inconnu)
BSAT 116213300 (Skatut inconnu)
BSA1116213900 (Statut inconnu)

B541116214400 (Statut inconnu)

<<Table | Lorcc

Fitre : [ =

m
ESAL116238700 2Smm

z 14000tum_mn 11000k _mn
] BSA1116244600 2Smm  S0mm  Zimm 6405 35800N 19300N 11000tun_mn 9000t mn
ZEI BSA1116218500 30mm  42mm  7mm 61606 4900 29le 18000turn mn 15000turn m‘r\—lﬂ
4 »
Fermer
.

EJ Démarrer  Fichier
A WASSEMBLAGE.
"BLO] sseveuace pauen ROULEME
oyl ANNEAL VIS (ANNEAU VIS, 1)

b ROUE DENTEE (ROUE DENTEE. 1)

—

b CALE CYLINDRIQUE (CALE CYLINDRIQUE. 1)

Edition  Affichage  Insertion  Qutils  Analyse

by COUVERCLE INT (COUVERCLE INT, 1)
Yo ARBRE DISQUE (ARBRE DISGUE. 1)
L‘Q-}JRONDELLE RESSORT (RONDELLE RESSORT. 1)

o DEMI TORE (DEML TORE. 1)

Q’:ﬁ 9200 (BSA11162:
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Assembly of components:

Before starting, it is possible, for better visibility, to hide the planes associated with each part:

ol B
. N N’
Press the Ctrl + F keys > In Name, enter: Plan* > == > select (all planes turn red)
> View > Hide/show > Hide/show (this function hides all selected items) > OK
Assembly of the two bearings and the cylindrical shim on the shaft
The tools that will be used are: > Coincidence constraint
> Contact constraint )
Shaft axis

For example, for the first bearing:

< = S - .
> =5 > Close Wizard message > ~" bearing axis > ~ shaft axis
Consequence: the bearing is aligned with the axis of the shaft

| 8 Bearing inner Shaft shoulder

\J -
> B @ > Close Wizard message > will be in “ the rolling surface which surface
contact with the shaft (inner ring surface)

| _|n

> the surface of the shaft that will be in contact with the bearing.
Consequence: The bearing comes into contact with the shaft shoulder

> Repeat the operation for the cylindrical shim and the second bearing.
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Assembly of the half-torus in the groove:

It is not possible to create contacts between toroidal surface (In our case: contact: half-torus and groove of the shaft.)

The approach consists in creating a central point at the level of the throat of the shaft, then in distancing a plane belonging to the half-torus
at this same point.

| ff-_ |

Centrer le graphe
DIROUEC_ gecadrersur

ho] BLOC R Cﬂ"’“famd"' )
For Propriétés

ol ANMEAL [E] Ouvri la sous-arborescance

ho] CALE ¢ b Couper aht [ )
ier Crl+C
bl COUVEF 3, Coler v

] RONDE]__ Colage spécal... RT.1)
hod DEMI Te__ Supprimer B

Obiet ARBRE DISQUE. 1 Edition

Point creation:

D > DISK TREE( in tree)
> Disc Tree Object.1 > Open in a new window

Quvrir dans une nouvelle fenétre

i . SR Composants » : .
In the new window: S ) ) Actverfpésactive o conposart
2 BSALLL Contraintes du composant
tﬁl Contrar R * G Degrés de berts du composant

[ Applications

| B
>\ POINT

K

> onthe edge of the groove

Définition de point

Type de port !'Z:ﬂ’fr au [t«;(‘r Jdnls u:_t!j
Corda | Sghérn | [igen  [Chartren 1w ite

Stitch type : Center of circle > OK
A dot should appear in the center of the throat

> Save the change (File — Save)

> Close disk tree window

Edge of the throat
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> Duplicate the half-torus as done previously for the bearing > Move the two half-toruses so

as to distinguish them > Create coincidence constraints between the half-torus axis and the
axis of the shaft. If necessary, rotate one of the 2 half-tori around its axis to prevent it from

merging with the other.

> Following the same procedure as on page 148, show the planes of the half-tori perpendicular
to their axis.

n‘ﬁ

> Using the distance function -] : Constrain the plane

perpendicular to the axis of the half torus to a distance of 1 (or -1) from the point
created previously (depending on the side of the groove chosen)
> Repeat the operation for the second half-torus

As we saw during the construction of the half-torus, each half-torus covers 179°. To prevent
them from colliding, we can constrain them angularly:

> E‘]/] @ > Between the faces of the two half tori > Angle: 180°
> OK > OK

Note: This operation is equivalent to gluing the two surfaces together.
Half-torus: Side 1

Half-torus: Face 2

Propridtés des comtraintes

S8 L] Mesire
Mo : [Dacalage. 10

Ederwrts agns

e |G ' I St |

Pan  DEMI TORE (DEMI TORE.2) Connecté

POt  ARBRE DISQUE (ARBRE DISQUE. L) Connecté

Point Plane perpendicular to axis

M M O V0N

b T
e 180 - ]
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Assembly of the other components:

The assembly of the other components is done in the same way as the bearings and the cylindrical shim, using the tools seen
previously.

Build the next assembly

Note: The illustration below shows the relative positioning of the parts in relation to the others

2 )y

For the RING VIS part, you must create a point on the axis of the part and put a distance constraint between this point and the point already
created in the center of the groove.

Note : for clarity, it is possible to modify the color of the parts and make them transparent:

| BN [
@ BEARING BLOCK (in the tree structure) > " Properties > * Graph tab > Choose a color > activate
a8

Transparency > " Apply > OK

August 2010
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M4 x 25 mm screw assembly Sélections|  Vis -@ 3 sasicue |
BSAB11904025 (Statut incannu) = SR ] [Nen valug —
Inserting the screws: ESABTAD0A0ZS (Statuk heonnt) DF = x|[m D
-]:] BSAS16004025 {Statut inconnu) 5 o j' 2 « L
: >|[Honvale 2
>\ & Catalog > In the Selection drop-down list Y eseasisoios stas o % — mo
BSAS10304025 (Statut inconnu) Iﬂ £ 2[Nenvakié o
BT 5 * | [MNon valué B
go up to 3D_components > 2x VIS ~ 4 [» .
Filtre ¢ [(x."DF"==4mm) AND (x."L"==2Emm) | SR =] [Nonvale 3
. .y i P ~ | |Mon valué E
Search for screws using characteristics: [ Partwumber  [oF [L [1F Io; [x \ I as
1 BSABL1904025 4mm 25mm  22.3mm  7fSmm 2.7mn\ L.2mm  1mm Matiere > | |Mon valué 3
| B8 . . | BN . 2 BSAB74204025 4mm 25mm  22.3mm _— |
> S Multi-level filter > St M Binoculars 3 BSABIGO00402S dmm 25mm  22.9mm £ >
! —_ 4 BSASSIS0ZS dnn_ZSmm 25w

>L == 25 (screw length)

>0K

| B8
> 2x reférence screws BSA816004025 (3 ° in the list) > OK > close the Catalog window

Binocular Multi-level filter

Screw assembly:

> Constrain a screw using the constraints of coincidence and contact with respect =
to the hole accommodating the M6 screws (in the cogwheel)

< Garder le ben avec le motd

Wm:wsmnmaw
& s diintion dy motd

Copy of the 4 screws in a circular pattern e
o Répartn crodare. |
D Y C—
>\ #3 REUSE A PATTERN eyt i )
. C A1 G (BSAS1000IS 1)
Fremére rstance s le motd ,
> Pattern : ' a circular pattern hole made for the wheel e e = =
T e T —
(D Cortadt arfac ROUE DENTEE (.. "wl-‘l' crodar. .
> Component to duplicate : -~ screws BSA816004025 R e e e

(] Pacer les rousenbes retances San un Comgsant fexbie

[ S _ox | Sispiom| rese |
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> Apply > OK

M6 x 20 mm screw assembly

Refer to the figure on the right for the positioning of the M6 x 20 mm screws

Perform the same operations as those seen previously

The screws to choose are: BSA816006020 (10th in the list)

M4 x 10 mm screw assembly

Refer to the figure on the right for the positioning of the M4 x 10 mm screws

Perform the same operations as before

The screws to choose are: BSA861004010 (14th in the list)

e g v sedes ot s s o (et e

D o | Sntow] twse |
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Key Assembly

Choose from the catalog the key (width 8 mm and length 40 mm) reference: BSA1026063000
Assemble the key to the DISK SHAFT using all the tools seen previously
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19. BASIC EXERCISE #14. 2D BEARING ASSEMBLY

B=&mm L= 40mm

I CLAVETTE
I VS W 10
_I WIS W20
[ VIS Waszs
w| 2 FOULEMENT A BLLES
C e i TORE 7C
[ AONDELLE RESSORT 535 269]
T ARBAE DISGUE SR Mos
[} 1 COUVERCLE INT 2C 48
5 COUVERCLE EXT ICH
I CALE CYLINDAIGUE ZCe
FGUE GENTEE EELLE |
Z RANER] ViE ZC4
7 BLOC NOVLEMENT EN AG-AISIW003 16,
T | e | o e e
= Z2.07.2000 Jenniier QRSPArOUR o
= 1:1
Torvem G @
wwwwww
==k = BTl

m:thSEMBLAGE_PALIEH o
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FINAL RESULT

Start Menu > Drafting > Standard: DETAIL 1SO > Shape Style: A3 ISO > Orientation: Landscape > OK
File menu > Save > (default location, or as indicated) > file name: ASSEMBLAGE_PALIER > Save

Perform assembly drawing.

Note: In section views, shafts should not be cut:

BN
> @K TREE (in the tree structure of the 3D window) > Properties >

Drawing > Enable Uncut in section views > Apply > OK

tab

To insert the parts list:

1]
™ 8 |51 oF PIECES

To edit this list:
> Edit menu > Layer Background

To return to the drawing:
> Edit menu > View layer

To number the parts:

K1
> W g PART NUMBER (behind TEXT) (of
course the part number must match the number in the parts
list)

11
E1®
A

" ASSEMBLAGE_PALIER
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20. ADDITIONAL EXERCISES
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1 | 2 | 3 | 4 5 | 6 ] 7 8
174
A 172 .
1635
| 437
42
= I~
~ w a.
&= o~ w© w
8 e 5 Q sl
AlS N A
_ — s N T _i
\.._H o v
o]
=| |[ .13 H13
C < ©
Q 8
ot
[©[0015 |A] ©[001s_[A

¥ g
P77 77

o 25 10 ¢e
E 66 | 0 N
%/ )
Coupe A-A
- . 30.04.2008 Jenraler Geapercus [
? : 1:1
F ‘ = A3 | 1 |1

Anglage général 0,5x45°
|

j Arbre d'entrainement
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1 2 3 4 5 6 7 8
A
| 52
45
38 ~
B 2 E“ 0 w0 =
2 36 %4 &) =i
L0 o~ —
64 — = -4
. a | a 2 .
sl SN Q{
_ ™| - 15 | O 4 = - 1]
=l /
% ‘p - 1! B -
% | \a
o N2 w
C v
J_l 002 |A 2
- Coupe A-A
D
) %
: NN
Y Y
S ¥ ¥
s Cnumas 30.04.2008 Junrifer Gasperous s
1:1
5 S
" [ 20 Maariau non détri T L =
: —h A3 | 1 | 1
Chanfrrein 0.1....0.2 . e e
(Wl Axe RouE FoLLE
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2 3 | 4 5 6 7 8
-
89 -
30 43
16,91 = o S
9
o 2. g <
1—‘ — .
L | 711
o~
R2 LG <r —7\ &
o~
’ ~
S 12 ‘
o 4> g
&
o ) b
T o9
86 9 o
% o \ e
(o]
R I T \ Ve ¥ N~
) L ‘
A A
o~
Dessie 05.05.2008 Jennifer Gasparoux Echele
s i [ 1 :1
Sans nomencianre staards (] N ::‘:;:n 5% EI@
Nomerclsnes sep e méme N° (I Mazere atériau non défini orgre Pt P tonifon P I
Nomerclspre sap de N cff (I Mazeo = Okg = Homplace A4 1 1

(PFAB ~  ARTICULATION
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1 : 4 | | il a
302
268
250
232
10
) 95
Q@ 16 1008
bt
- N
o4
—5 3
o L1
8 o £ 8
o y ﬂ\}d‘ F /
5 A 1 =2
S @ / Q
QU
i L i F
NZ 4
i 25 x45° 1
.AI 9
° sk : 80
92
Q5
130 50
N9
Anglages générales 0,2 x 45°
eant 05.05.2008 Jennifer Gasparcux aal
o . 1.2
= A3 | 1 | 1
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3 | 5 | 6 | 7 | 8
50
15
20 . 33
% T " © 7
7 - 3
S, Q
< 2 o
X =1 g, £s
A =2 2, — A
o
—— & -
-
A1
L —
9V
-
76 /'
120
3,02
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21 @5 g1 7
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1476
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21. ADDITIONAL EXERCISE 1: COMPRESSION SPRING

$RESSORT
=7 Plan xy
— .= Plan yz
== Plan zx

@ Poche. 1

r@ Set géométrique. 1

< Hélice. 1
* Point.1
% Cercle. 1

- Plan. 1
* Point.3
-’\'_',\«' Cercle,2

®-$3% Corps principal
&4 Nervure., 1
€7 Nervure, 2
@ Nervure, 3

FINAL RESULT

Technical characteristics: e @ of

wire: 0.5 mm « & of winding: 14
mm e length L under load:
15.3mm « number of active spins
Na =4 ¢ pitch p = 3.75mm

August 2010
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Start menu > Generative Shape Design > enter the name of the part: SPRING > OK
File menu > Save > L: Catia > file name: SPRING > Save

HELIX:

o)

PROPELLER (behind T CURVE) e |

o ©
Departure Point > " Create the point

Coordinates : X=7mm
Y=0mm
Z=0mm

BN

" okay

|_BN
Axis > Z axis > Pitch :

3.75mm > > Height : 15mm
>

XD

" okay

EPFL
Définition de la courbe Hélice ' 2l x|
Point de départ: F’r-lnr 1 . I
Axe: ez
Type
Pas: I 3,75mm E Loi..
Révolutions: | 1
Hauteur: l 15mm
Orientation : ISens inverse des aiguilles ;J
Angle de départ : |Udeg
Variation du rayon
@ angle de variation: IUdeQ Sens’lDiminution _'J
O Profil: [Pas de sélection
Inverser |a direction |
@ ok | Sannuer| apercu |
[ -

Note: A spring is always drawn in its mounted configuration in an assembly: compressed for a compression spring, stretched for an extension spring.

- 165 -
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Start > Part Design

| IVJ l Ir @L
" the ZX plane in the tree structure > SKETCH
SN0 K . m
~" *» CIRCLE > < the centeronthe Haxis > " any diameter (the circle turns red)
| :_J ij . i_; .
CONSTRAINTS > set dimension > 2x " on the diameter value > enter 0.5 > OK
BN _ |_Bs _ ' i‘. %
" center of the circle > CTRL the lower end of the helix > - & SELECTED CONSTRAINTS IN A BOX OF
BN BN
DIALOGUE > * Coincidence > Ok~ o

T
7 El | EAVING THE WORKSHOP

i e

August 2010 - 166 -



Machine Translated by Google

Introduction to Computer Aided Design (CAD) EPFL

RIB:

Start > Part Design

Définition de la neryure

EI/] @ RIB

Message Warning > OK Profil :

Profile: Sketch.1 (default)

Courbe guide ; [Hélice. 1

Guide curve: Propeller.1 — Contrdle du profil

lConserver ['angle ;I

Sélection: |Pas de sélection

B

- okay

[] nervure relimitée [] Epaissir le profil
— Nervure fine

Epaisseurl: | 1mm
Epaisseur2; {BOmm
(I Fibre neutre [ Extrémités refimitées

- Annulerl Apercu l
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Start > Generative Shape Design

CIRCLES:

[ 88
\_/ O.,, CIRCLE

Circle Type: Center — Radius

Center :

o ©
Center> -/ Create the point

Coordinates : X=0mm
Y=0mm
Z=0mm

BN

. okay

Support: XY plane
Radius: 7mm

Start : Odeg
End : _310deg
&
./ okay

Définition du cercle 2| x|
Type de cercle : ICentre - Rayon EI

Ewriras [Pont.2 = I —Relimitations du cercle
IQ @l‘f,"- |v7.[
Début: [0 [

Support ¢ |Plan xy

Rayon ; || 7rom
Fin: ]’310669 E
[] Géométrie sur support

[ Caleul de l'axe

Direction de l'axe ; |Pas de sélection

@ oK & annuler | Apercu |

August 2010
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To do the same on the upper part of the helix, you need two points and a plane, necessary for sketching the circle.

Creation of the first point:

7w POINT 2]
Type de point ; !Centre 'l
Stitch type: Circle center Cerde { sphire : [Nervure. 1\Aréte.2
Circle / sphere: Upper end of the helix F ok_] @ aoner | _persu_|
\‘/okay

Plan creation:

| 8
\_/ Ll
PLAN Définition du plan

Type of plane: Parallel through a
point Reference: XY plane Point:

Point.3 (= last point created) o GO

Point : IPoint.S

L

@ ok | @annuer | apercu |

2)X]
Ll Paralele par un poirid]

okay
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Creation of the second point (= center of the circle):

KL =
b » POINT

Point type: On plane
Plane: Plan.1 (= last plane created)

H=0mm
V=0mm
\'/okay

Creation of the circle:

KL
s Ov CIRCLE

Type of circle: Center — Radius
Center: Point.4 (=last point created)
Support: Plan.1 (= last plan created)
Radius: 7mm

Start: Odeg
End: 310deg
\Jokay

Type de point : [Sur plan

Plan : {Plan.1

H: | omm

Vi | orom

[ E Ut

Référence

Point :  |Défaut (Origine)

Projection

Surface ; |DéFaut (Aucun)

@ ok | @ annuer |
[ -

Apercy_|

Deéfinition du cercle

?IX]

Type de cercle : |Centre - Rayon - i

Centre ; JPuint. 4

Relimitations du cercle

F oLl |

Support :  |Plan. 1

Début : |Odeg
Rayon : I Fmm @
; Fin : 310deg @
[[] Géométrie sur support

[ Caleul de l'axe

Direction de l'axe :

& Annuler ] Apercu ]

August 2010



Machine Translated by Google

Introduction to Computer Aided Design (CAD)

EPFL

Start Menu > Part Design

|_BE
N

& LEAVING THE WORKSHOP

RIB: '
S o @

~ upper circular surface of the propeller > = SKETCH \
0o 2 [ . ‘
-/ #5% PROJECTION OF 3D ELEMENTS > -~ ypper circular surface of the propeller

The sketch thus created appears in white, it resumes the outline of the upper circular surface of the propeller

Définition de la nervure E|@

Profil : [Esqusse.s _E—’J_I

Courbe guide t [cooo— E’”
ContrGle du profil

f < &
~ Sketch.3 (last sketch created) > = RIB

Profile: Sketch.3 (last sketch created)

4 ]Conserver Fangle j
Gulde Curve CIrCIe-Z f / gl;lewuerellmltée DEpavssIrIeproil
Nervure fine
" okay " 3
r
August 2010

-171 -



Machine Translated by Google

Introduction to Computer Aided Design (CAD)

EPFL

Do the same for the lower part of the spring:

L .
" Sketch.1 in tree >

&

Profile : Sketch.1
Guide Curve: Circle.1

E]@ RIB

- okay
Définition de la nervure AR
R [Esquisse. 1 @‘_",l
Courbe guide ; W @l
—Contrdle du profilf ———————————
IConserver l'angle _':_I
Sélection! |Pas de sélection
[ mervure relimitée [_] Epaissir le profil
—Nervure fine
Epaisseur: I Imm
Epaisseur? Iljrnm E
E[ Fibre neutre [:[ Extrémités relimitées
- Annular‘ Apercu I
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CHOPPED OFF : : |
" 0 ]
EI/] the YZ plan > E:] @1 SKETCH _
= i
!:E ¥ Rectangle > according to the sketch opposite
E] ely LEAVING THE WORKSHOP S A — - | T
v ¥

August 2010
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@ POACHED

First limit:
Type: to the last
@ More >>

Second Limit
Type: to the last

Selection: Sketch.4 (default)

$:

-/ Reverse side

E:B okay

File > Save

BIRESSORT

< Plan xy
=<7 Plan yz
=<7 Plan zx

#='33 Corps principal

=45/ Nervure. 1
f Esquisse. 1
¥ Heélice. 1
==&/ Nervure.3
? Esquisse.3
L licerde.2

== i/ Nervure.4
£ Esquisse, 1
5 " Cerde.1

-

- Esquisse.4
==L Set géométrique. 1
E # Hélice.1
~:Esquisse, 1

< Cerde.t

* Point.3
&7 Plan.1

" Point.4

L Cerde.2
¥ Esquisse.3

0.15

Définition de la poche E"X'

[ Premiére limite -Seconde limite
;Typa H Jusqu'au dernier - Type @ Jusqu'au dernier -
Décalage : | Omm Décalage : Omm @
.:iﬁ&lfsurfaﬁa - Direction
| Sélection : |Esquisse. 4 @ '3 Perpendiculaire au contour
Référence :|Pas de sélection
-Poche Fine —————————————
gagge] | Drbre evtre T Extrémiss relimtés
@ Ok ! iAml.IarI Apercu i

August 2010
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22. COMPLEMENTARY EXERCISE 2: SPRIGHT GEAR WITH HELICAL TOOTHING

hnical cl TR E
tooth: spur gear with helical teeth « number of teeth
Z=24 « Pitch @ d=127.32mm ¢ Pitch pitch p=16.65 * Tooth

width s=8.5mm « Head @ da=137.7mm « & foot df=114mm
* helix angle y=11°

FINAL RESULT
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Start Menu > Part Design > enter part name: SPROCKET > OK
File menu > Save > L: Catia > file name: SPROCKET > Save

CYLINDER

- _ 0 @2 =
~~ the ZX plane in the tree structure > ~ SKETCH

Draw the sketch according to the figure opposite

|_BN
£ LEAVING THE WORKSHOP — -

= # REVOLUTION
AXis > Selection: horizontal axis H :

./ okay

s =0

-176 -
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TOOTH

7,
E/D One of the faces of the cylinder > F_/] E“' SKETCH > Draw the sketch of the tooth (according to the figures below)
Method :

Note: the tooth profile proposed here is an

1. draw the left half of the tooth 2. create approximation of a real profile (circle involutes)

a vertical axis coinciding with the V axis
3. mirror this axis

SYMMETRY

v

@ !i'l LEAVING THE WORKSHOP
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COPY OF TOOTH SKETCH:

O ©

Sketch.2 (in tree view) > CTRL + C > the second side of the cylinder > CTRL +V

Note: A second sketch identical to the first appears on the second face of the cylinder.

>2x@

Sketch.3 (in tree view)

Assistance :

* Remove the verticality of the axis of symmetry,
give an angle of 11° with respect to the axis
V.

» Beware of automatic constraints that fix points
on the V axis: delete « Check that the sketch

is entirely
constraint: in green

e I.'h LEAVING THE WORKSHOP
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CREATING A GUIDE
eéé LAW

n de la droite

Type de droite :|Paint-Point |
Point 1:  |Esquisse.2{Sommet. 1

Point 2: |Esquisse.3|Sommet.2

Support: |Défaut {Aucun)
Début ; | Omm =

Jusqu'd : |Pas de sélection
CFin:  fomm )

Jusqu'd : |Pas de sélection

" Type de Longueu
@ Longuewr O Paint Début Infini
O Infinie O Paint Fin Infini

[ Extension symétrique
r- 1 &; : ; ;v,,.‘.,.{:,

okay
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CREATING A MULTI-SECTION SOLID

8 @ SOLID MULTI-SECTIONS \

e Sketch.2 > e Sketch.3

[Définition du solide mult-sections ——SSNKTFY|
5 guide > 5 Right.1

Mon | Section | Tangente | Point de fermeture |
1 Esquisse.2 Esquisse.2\Sommet,3

I 2 3 Esquisse.3\Sommet, 4

Note 1: Check that closing point 1 Gudes | Amature | Couplage | Relmitation |
is opposite closing point 2. If not, follow

the next procedure.

Non | Guide [ Tangente |
1 Droite.]

RemEIacer | Enlever | Ajouter |

@ closing point2 > E—:I/]to replace

Paramétres de lissage

[] Correction angulaire : ID,Sdeg E

e "the point of sketch.3 being in front of

the closing point1, on on sketch.2" Lipedune B =
- Jra—p—
T

Note 2: Check the arrow direction of both sketches, at the closing point. The two arrows should point to the

same direction. If not > e an arrow (it changes direction)

>0
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CIRCULAR REPEAT

© 8. CrcuLar REPEAT
e Reference element > one side of the cylinder

e Component > E/D Multi-section solid
Parameters: full crown

Instances: 24

20

Définition de la répétition circulaire

Référence axiale | Définition d'une couronne |

Parametres: | Couranne entigre =l
Instances | |24 L2

Espacement angulaire ; | 15020 —] @
angle total : |360deg E@

— Direction de référence

Elément de référence:lRévolutinn. 1\Face
Inversion Q la direction I

Composant & copier

Composant ¢ |Solide multi-sections. 1 ﬁl

[] Conserver les spécifications

-

Plus>>|
@ oK l ﬁnmderl Apercu I
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HOLE

Make a through hole, diameter 80 mm, centered on the pinion.

File > Save

tion du trou

lJusqu'aJ dernier j

Diamétre : Im E ’é_
Profondeur ;ISDmrn E@
Limite : |F‘as de sélection

Extension | Type | Définition du taraudage |

— Edition de l'esquisse
Décalage : |Omm [
—Direction Fond
Inverser [Cimite =
'3 Perpendiculaire & la surface Angle | [120deg

|Pas de sélection

@ oK I Onmdu'l Apercu I
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23. COMPLEMENTARY EXERCISE N°3: CONNECTING ROD

This exercise aims to present a new approach and tools. The part in question can be obtained with all the tools seen previously.
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Start menu > Part design > Enter the name of the part: ROD > OK
File menu > Save > (default location, or as indicated) > file name: BIELLE > Save

In the XY plane, draw a circle of diameter 54.

LEAVING THE WORKSHOP

o @' EXTRUSION > Type: Length > enter 9 > OK

Select the two plane faces of the cylinder:

|_BN |_BN Définition de la cogue

" on a face > keep the Ctrl key pressed > (the two "~ on the other side S 6 &
selected elements turn red) > release the Ctrl key. Epelovsur wxbliioins = @l

Faces & rotier : §|
!EP @ i i Eaces & épatsseurs dfférentes : [Pas de séection UQI
HULL > Interior thickness: enter O

o Outside thickness: enter 6 b [0 ) Somuel

>
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3 |biele

Insert menu > Body (a new Body appears in the tree view) < Plan xy

_ _ _ < Plan yz
In the XY plane, draw a circle of diameter 24, the center on the H axis, = Blars 24
located 150 mm from the center of the first circle. i_/ o

i@ Corps principal
150 ‘f - 9 Corps de piéce.2

BN
hd l‘l‘l LEAVING THE WORKSHOP

After making a 9mm extrusion from this sketch, As before, create a shell with interior thickness 0 and exterior thickness 4.
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”3,§?
\_/

v

(at the very top of the list of buttons on the right) >

In the list of buttons on the right, find and click on the ADD icon Add :?e!ect Part
body.2 in the tree structure A : Main body (by default)

After : Shell.1 (default)
>0K

Ajouter [Corps de pibee.2

biele
A
< Plan xy

Apres: |

S ok | O nnder| soersy |

3 bielle
The tree then appears as shown in the figure (Part Body.2 has — = Plan xy
disappeared) = Plan yz
< Plan zx
ﬂé} Corps principal

K
Yt % (at the very top of the list of buttons on the right) > o (Part Design)

(Generative Shape Design)

Bienvenue dans CATIA V5

‘

anewn Assembly Design  Drafting

EQ

Generative Shape Design  FreeStyle
Eﬂawn‘ﬁthutettubohmd&nmm Fermer |

omaa@apm Ja!

\
t‘

8 BRD
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CREATION OF THE CONNECTING ROD BODY = 14
Insert menu > Part Body (Part Body.3 appears in the B H
tree view)

In the XY plane, draw the profile as it is in the figure
The AF segment is coincident with the H axis.

Arc CD is tangent to segment DE.
&0

ey LEAVING THE WORKSHOP

o 5
et EXTRUSION > Type: Length >
enter 7 > OK
[ 88
" upper face of the created part

o
— & SKETCH and Draw the profile below:

e 19 o]
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EI/] li'l LEAVING THE WORKSHOP
e B- POCKET > Length: 4, Selection: Sketch.4 (default) > OK

!—j/] next to the room

!_:I/] % SYMMETRY > !_]/:] plane of symmetry
>0K

RELIMITATION OF THE ROOM

U

EI/] Part body.3 (in tree view)

(at the very top of the list of buttons on the right) > E—]/] E (Generative Shape Design)

I LN

O 88 PARTIAL RESTRICTION

LD &

— & T

[Relimitation partielle|

-188 -
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Sides to remove > sides shown below

-welimitation partielle

Corps : |Corps de prce.3

[
Faces & retires : !I
Faces & garder : Wg

9 ok | Saenier| apergu |

Faces a retirer

RAS e CLIDAG

>0K
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REALIZATION OF EDGE FILLES

EI/] & (at the very top of the list of buttons on the right) > !:9 @ (Part Design)

UN .U

the 10 edges shown in the figure below (while holding down the Ctrl key) > Radius: 5 > OK

IMfimitien du cangs

END OF CONNECTING ROD

e % sYMMETRY > Eg symmetry plane ( XY plane) > OK

File menu > Save
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Guidelines for managing Catia assemblies

24. File naming

Two files cannot have the same name. We advise you to follow the name of the part with your initials and a number. Example:
axis_MB_009

Do not rename files.
Do not use accents and special characters in file names.

25. Backing up files Backing up
files is done with the recording manager : File / Recording management

Gestion des enregistrements @
Etat Mo Chermin Action

MNouveau Partl.CATPart Enrﬂlstref S0us. .. I

fichier(s) non enregistré(s) [ Enregistrements indépendants

It is strongly recommended to save all the files in your "Permanent Data" (also with parts imported from TracePart or other).
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26. Structure of assemblies A

sub-assembly must be created if it can be assembled independently by an assembler on the shop floor.
For each 3D assembly, a 2D drawing must be made with a BOM and parts list.

27. Example of an assembly containing several sub-assemblies A
gearbox is made up of a primary shaft, a secondary shaft, a casing and accessories (screws, lever, oil cap, seals, etc.) .

The assembly structure will be as follows: 1 main

assembly named Boite_de_vitesses_MB_001.CatProduct containing the following sub-assemblies:
y 1 sub-assembly named Main_shaft MB_002.CatProduct containing all the main shaft parts y 1 sub-assembly named
Secondary_Shaft_ MB_003.CatProduct containing all the secondary shaft parts y 1 sub-assembly named
Carter_MB_004.CatProduct containing the crankcase and all the accessories

A drawing will be made for each assembly and sub-assembly, namely: y 1
drawing named Boite_de_vitesses_MB_001.CatDrawing y 1 drawing named
Arbre_principal_MB_002.CatDrawing ¥ 1 drawing named
Arbre_secaire_MB_003.CatDrawing y 1 drawing named
Carter_MB_004 .CatDrawing

main shaft
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5
@Arbre _primaire_MB_002 (Arbre_primaire_MB_002.1)
@ Arbre_secondaire_MB_003 (Arbre_secondaire_MB_003.1)
@ Carter_MB_004 (Carter_MB_004.1)
Applications

Gearbox_MB_001.CatProduct

Mise en plan de la
boite de vitesse

Mise en plan de 1'
arbre principal
—_—
I Main_tree_MB_002.CatProduct
— Mise en plan de 1'
—> Secondary_tree_MB_003.CatProduct arbre secondaire
Mise en plan du
—_—
= Carter_MB_004.CatProduct carter
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28. Example of drawing of an assembly and its sub-assemblies For the links

between the documents to be coherent, the drawing of a sub-assembly must be done when this assembly is opened
in an independent window.

In the following case, the drawing of Child Assembly 1 requires it to be opened in a new window.
P semblage Pere

'}%"lnssemblage Enfant 1 (Assemblage Enfant 1.1)
'@Piece 1 (Piece 1.1)
-@F‘iece 2 (Piece 2.1)
g’l Assemblage Enfant 2 {Assemblage Enfant 2.1)
Applications

When Parent Assembly is enabled, right click on Child Assembly 1, then Child Assembly Object 1.1, and Open in New Window.

PN Fissenblage Perel
=-1%." fssemblage Enfart 1 {Assemblage Enfant 1.1}
HglPiece 1 (Piece 1.1) Eﬁ":ﬂ s graphe
#-3},)Piece 2 (Piece 2.1) cat i
‘@?Assemblage Enfant 2 {(Assemblage Enfant 2.1 Lf"! Cgcht-et,ir'nuntrer
3 [ Propriétés
Appications & Couper Ctri+%
Copier Ctr+C
(R Coller Cri+v
Collage spécial...
Supprimer Del
Objet Assemblage Enfant 1.1 Edition |
c T > Quyvrir dans une nouvelle fenétre |
it g () Activer { Inactiver le composant
Représentations L4
T | B
ode de sélection S Degrés de liberté du composant
la Eixieé
£55 Flexiblerigide

"5 BropagerIa posiion surla référence

Sub-assembly drawing can be done when the top-level item in the specification tree is the sub-assembly.

?

BaPitce 1 (Pidce 1.1)

t:;ﬁece 2 {Pidce 2.1)
pplications
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In order to check that the links are correct, in the drawing, go to Edit / Links. The pointed element must be the sub-assembly and not

the parent assembly.

29. Example of replacing a

Liens du document Drawing1.CATDrawing
[ Lens | Documents porss |

Type de lien: |({Tous) | Propriétaire: |(Tous) -

Rafraichir ! Liens: 1 OK
Document pointé : Assemblage Enfant 1,CATProduct

Elément pointant | Elément pointé Document Type de lien | Propriétaire | Statut |
Assemblage Enfant 1  Assemblage Enfant 1.CATProduct  ViewLink Calque. 1 OK

@ ok | @ annuler |

part by another What does not work

(except in special cases): A user A creates an assembly in which is

located a part that he has named Piecel (Piecel.CATPart).
A user B creates a part which he names Piecel (Piecel.CATPart).

User A would like to recover Piecel from user B... He therefore copies the file and overwrites his Piecel.CATPart file.
When opening his assembly, he gets the following message !!! Indeed, the name is identical but the UID is different. (For more

information, refer to paragraph 8: Managing file names)

Quvrir

Les fichiers suivants n'ont pas été trouvés ou ne contiennent pas les bonnes informations.

|LiiCaTIAYMEthadologiel PIECE L. CATPart
Utiliser la commande Bureau pour retrouver les

bans fichiers.
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What works* A
user A creates an assembly containing a part that he named Piecel_userA (Piecel_userA.CATPart).

User B creates a part that he names Piecel_userB (Piecel_userB.CATPart).

User A would like to retrieve User B's Piecel... He therefore copies the Piecel_userB.CATPart file into his directory, opens his assembly
and by right-clicking on Piecel_userA (see illustration)

by | Prodiuct1}

Centrer le graphe
Centrer sur
(2] cacher fmontrer
Propriétés
% Couper Chrl4+x
Copier Chrl+C
(2 Coller Chrl+y
Collage spécial. ..

Applications

Supprimer Del

Objet Piecel _utilisateura. 1 4

B4 Remplacer le Composant en Session. ..
Représentations 14| * * Remplacer le Composant. ..
B s Definir le contexte
) Charger
B Décharger

Les impacts au remplacement de ce produit

Ces éléments vonk étre é I de. voulez vous continuer 7
Type [ om [ Source |

He selects the Room1 userB.CATPart file and clicks OK in the next window.

Woulez vous remplacer toutes les instances de ['élément sélectionné ?
@ ou O Non

@70k | @ annuler
-

The instance name has not changed and is no longer

rdUCtl consistent. (cf. Managing file names)
Piece1_utiisateurt (Fiece1_utilisateurA. 1) . .
It must be changed manually by editing the properties of

each instance of Piecel_userB
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30. Transmission of files to another user

In order not to be dependent on file paths, proceed as follows:
File /send to / directory
Select the files you want to copy and the destination folder:

Envoi dans un répertoire @@
Fichiers Candidats

Nom | Type [ Emplacement [ Trouvé |

P2

[ conserve Iarborescence initiale

Fichiers Selectionnés

Wom | Type \ Emplacement. | Prablzme J Nom cible ~

ANNEAUEXT B... CATPart C:\Documents and Set... ANNEAU EXT ...

ANNEAUEXT 9... CATPart C:\Documents and Set.,, ANNEAU EXT ...

ANNEAUINT 5... CATPart C:\Documents and Set... ANNEAU INT ...

ANNEAUINT 5... CATPart C:\Documents and Sek.., ANNEAU INT ...

ARBRE 60-210.  CATPart C:\Documents and Set... ARBRE 60-210,

Assemblage du.,. CATProduct C:\Documents and Set. ., Assemblage d...

BSA100711220.,. CATPart C:\Documents and Set... BSAL0071122,..

B5AB16006020.,, CATPart C:\Documents and Set. . B5AG1600602, .

B5A871100030.,. CATPart C:\Documents and Set BSAS7110003,.

CLAYETTE 18-8... CATPart C:\Documents and Set... CLAYETTE 18-...

ClAVFTTF 75-8... CATPart CADariments and Set €1 AWFTTF 75- pet
Taille : 4,74 Mo

Copier vers ;‘(;“Emp

-

Note: All the documents of the CATIA session must be saved beforehand, the easiest way being to do this operation when the session is
empty (without open document).
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31. File name management

Propriétés @@
Sélection : ] J
Produit | Graphigue | Mécanique ] Dessin I

A
Compos A Part/ Product. Instance
Nom de linstance | piece. 1 Information
Description
> Properties specific to
each use or instance
of the part/product
4 Visualise dans la nomenclature
Lien vers la référence = 1
Piece | L:\CATIA\MEthodologiel\Piece. CATPart
Produit Part/Product Reference
RéFérence Eece| Information
Réxisi ’
i | i Properties common to
homenclature | all uses or instances of
Source lm the part/product
Description
)

[£

S
|

|° oK I @ appliquer | Fermer |
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A part (or product) used in an assembly has three names:
- the name of the reference

- the name of the file - the

name of its instance (use)
For consistency, it is recommended that these three names be identical.
The instance name is constructed when inserting the part into the assembly from the reference name plus a point and increment. There is no
automatic mechanism that changes the name of the instances when the name of the reference changes, this operation must be performed
manually (in the case of the replacement of one part by another for example).

A few rules to follow: The file

name (.CATPart, .CATProduct, .CATDrawing) must be unique.

In a CATIA session, two different parts cannot have the same reference name (automatic verification).
The instance name must be unique within a single assembly level.

Each CATIA file is also identified by a unique, non-editable UID. Inter-document links are based on both document names and UIDs. Any
replacement of a part by another outside of CATIA is therefore likely to fail! (cf. Example of replacing one part with another)
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